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Resumen

Los procesos de deformacién plastica severa en cercanias de la superficie,
seguidos de recocidos a bajas temperaturas, han demostrado ser altamente
efectivos para generar micro/nano granos en la capa superficial de los

materiales.

En este contexto, en esta tesis se ha desarrollado y estudiado una técnica
innovadora que simula y reemplaza uno de los procesos de deformacion
plastica superficial existentes, el arenado. El objetivo es lograr una red
uniforme de zonas de alta deformacion en la superficie del material, actuante

como centros de nucleacion durante el recocido posterior.

El método propuesto consiste en una laminacion en frio utilizando rodillos
rugosos, seguido de una recristalizacion a bajas temperaturas y, a diferencia
del arenado convencional, ofrece la ventaja de ser un procesamiento

continuo con una alta productividad.

Para el estudio de este proceso, se llevaron a cabo laminaciones en frio de
placas de acero inoxidable austenitico utilizando rodillos rugosos, y
posteriormente se realizaron recocidos a temperaturas comprendidas entre
200°C y 400°C durante una hora. Los analisis microestructurales mediante
microscopia optica y electronica revelaron la presencia de nuevos granos
superficiales pequefios, algunos de 200-300 nm, distribuidos de forma

heterogénea, lo que aumenta la resistencia al desgaste del material.

Dado que la rugosidad impuesta por los rodillos desempeiia un rol clave en
1



la determinacion de las propiedades finales, especificamente en la
deformacion plastica y microestructura superficial, se realizé un estudio
numérico del proceso propuesto mediante elementos finitos para
comprender esa influencia y predecir su efecto en los nuevos granos
superficiales obtenidos, y luego correlacionarlo con la evidencia

experimental.

Esta simulacién numérica revelo la presencia de una deformacion plastica
severa distribuida de forma heterogénea en toda la superficie, un resultado
gue se alinea con los resultados de los analisis microestructurales, donde
se observé que la formacion de nuevos granos también fue localizada de
manera no homogénea. A pesar de esta heterogeneidad en la distribucion
de la microestructura, la presencia de granos mas pequefios en la superficie
condujo a mejoras significativas en las propiedades mecanicas. Se registro
un aumento del 20% en la nano dureza superficial en comparacién con el
centro de la pieza y reducciones del 26% y 45 % en la profundidad del
desgaste y la pérdida de masa respectivamente.

En resumen, este método innovador ofrece una alternativa prometedora
para producir microestructuras y nanoestructuras que resultan en

propiedades mecénicas superficiales mejoradas.



Abstract

Severe surface plastic deformation processes followed by low-temperature
annealing have demonstrated remarkable effectiveness in generating
micro/nano grains within the surface layer of materials. In this context, an
innovative technique attempts to recreate the superficial deformation
occurring in the sandblasting process to create a uniform network of high-
strain zones on the material's surface. These high-strain zones act as
nucleation centers during subsequent annealing. However, the proposed
method has a significant advantage over sandblasting: it is a continuous

process with high productivity.

It begins with cold rolling using rough rolls and is followed by recrystallization

at low temperatures.

An austenitic stainless-steel sheet, previously normalized, was used as the
raw material. The samples were cold rolled using rough rolls, and annealed
at temperatures between 200°C and 400 °C for one hour. An optical and
electronic microstructure analysis showed the presence of small,
heterogeneously distributed surface grains of 200—300 nm in diameter. At
the same time, the surface grain refinement resulting from the proposed

process enhances the material's wear resistance.

Since the roughness imposed by the rolls plays a main role in determining
the final properties, particularly plastic deformation and surface
microstructure, a numerical study of the proposed process was undertaken

using finite elements to comprehend this influence and predict its impact on

3



the newly formed surface grains. This prediction was then correlated with

experimental evidence.

Finite element analysis revealed significant, inhomogeneous deformation
and likely responsible for the uneven distribution of the recrystallized grains;
this result is consistent with the microstructural analysis results, which
demonstrated localized formation of new grains. Despite the heterogeneity
in microstructure distribution, the presence of smaller grains on the surface
led to significant improvements in mechanical properties. Surface nano
hardness results showed a 20% increase with respect to the central zone of
the material and wear tests of the treated samples showed 26% and 45%

lower wear deep and mass loss, respectively.

In summary, this innovative method presents a promising alternative for
producing microstructures and nanostructures that result in enhanced

surface mechanical properties.



CAPITULO 1

INTRODUCCION

A lo largo de la historia, la busqueda constante de nuevos materiales con
propiedades mejoradas ha sido el motor impulsor de la ciencia y la ingenieria
de materiales. Desde de los comienzos de la civilizacion, la capacidad de
descubrir, sintetizar y aplicar materiales innovadores ha sido fundamental

para el progreso tecnoldgico y el desarrollo de la sociedad [1-3].

En el contexto actual, a medida que evolucionan las demandas tanto
tecnolégicas como sociales a nivel global y de pais, la necesidad de
materiales con propiedades especificas se ha vuelto mas apremiante que
nunca [2,4-6]. La industria [7-9], la medicina [10-12], la energia [13-15] y diversas
areas clave [16-21] dependen en gran medida de materiales avanzados que
cumplan con requisitos rigurosos y que a menudo van mas alla de lo que los

materiales tradicionales pueden ofrecer.

Este panorama presenta un desafio considerable para los investigadores en
el area de materiales, quienes se esfuerzan de manera continua en la
busqueda de generacién de todo tipo de nuevos y avanzados materiales con
propiedades mecanicas excepcionales [22-24]. En particular, en el caso de
metales y aleaciones, uno de los enfoques mas prominentes es la mejora
de su resistencia mecdanica a través de la optimizacién de su microestructura

[25-27].



Es ampliamente reconocido el hecho de que la resistencia mecanica y la
resistencia al desgaste tienden a mejorar con la reduccion del tamafo de
grano [28-30]. Por esta razon, las investigaciones enfocadas en el
refinamiento del tamafio de grano en metales tienen una historia de mas de
seis décadas [31]. Este refinamiento de grano se logra mediante distintas
técnicas como el control de la solidificacion [32,33] y/o mediante procesos en
estado sdlido, tales como la deformacion plastica severa[34]. Estos métodos
tienen la capacidad de refinar el grano fundamentalmente a escalas micro,
generando granos equiaxiales que se extienden de forma homogénea en

todo el volumen del material.

Se ha demostrado mediante extensas investigaciones que los metales y
aleaciones con granos ultrafinos exhiben excelentes propiedades fisicas y
mecdanicas en comparacion con aquellos metales y aleaciones de tamafio

de grano superior a micras [35-39].

Se ha corroborado que el refinamiento de grano puede conllevar en una
mejora sustancial de una amplia gama de propiedades en las que se
incluyen la resistencia a la corrosién [40-42], la resistencia al creep [43,44],
resistencia al picado [45], la resistencia a cavitacion y la erosion por

cavitacion [46,47], entre otras [40,48].

El aumento de la resistencia mecanica derivado del refinamiento del grano
suele ser gobernado por la ecuacién de Hall-Petch. Dicha ecuacién postula
gue a medida que el tamafio de grano disminuye, el limite elastico o esfuerzo
de fluencia del material aumenta, lo que se traduce en una mayor capacidad
de resistencia a la deformacion plastica [49,50]. Sin embargo, este aumento
significativo en las propiedades mecanicas a menudo se ve contrarrestado
por una menor ductilidad, lo que puede conducir a fallas catastréficas en

términos de fragilidad del componente.



Por otra parte, en numerosos casos, las fallas y las tensiones maximas
ocurren en proximidad de las regiones superficiales, lo que propicia que
muchas de las fallas en una pieza tengan origen en su superficie, incluyendo
fendmenos como el desgaste, la fatiga y la corrosion. Por consiguiente, el
tratamiento de la microestructura a nivel superficial puede desempefiar un
papel crucial en el control de las fallas [51,52]. Ofreciendo la ventaja de
procesar la superficie en lugar de toda la pieza. Es por esto por lo que,
numerosos estudios se han centrado en la mejora de las propiedades
superficiales de los materiales a través del refinamiento de los granos

superficiales.

En las Ultimas décadas, mdultiples técnicas de nanoestructuracién de
superficies han sido exitosamente desarrolladas [53-60]. Estas técnicas han
logrado la formacién de granos ultrafinos (ultrafine grains UFGS) vy
nanogranos (nanograins NGs) en la superficie de diversas clases de
materiales metalicos, incluyendo acero [61,62], aluminio [63,64], cobre [65,66],
niquel [53,67], titanio [57,68] y otras aleaciones [69-72]. De forma
complementaria, se ha comprobado que las superficies nanocristalinas
aportan mejoras sustanciales a los materiales metélicos convencionales,
alargando la vida util ante la fatiga debido a que la capa superficial impide
el movimiento de dislocacionesy retrasa la formacion de grietas [59,73]. Cabe
mencionar que las contribuciones de esta técnica van mucho mas alla, al
influir positivamente en aspectos como la dureza, la resistencia a la

corrosion y las propiedades triboldgicas.

Entre los procesos mas reproducibles para refinar los granos superficiales
se encuentran el granallado severo [74,75], el granallado ultrasénico
[66,76,77], el granallado de alta energia [78,79], la atricibn mecanica superficial
[80,81], el granallado de impacto ultrasénico [82,83] y otros [84,85]. Un
denominador comun en todos estos métodos de nanoestructuracion

superficial es la imposicion de deformaciones plasticas severas a altas
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velocidades, lo que da como resultado la formacion de una capa
nanoestructurada en la superficie y justo debajo de ella, al mismo tiempo
que expone el material a tensiones residuales de compresion mas

profundas.

Ademas de las técnicas mencionadas de refinamiento de grano a nivel
superficial, se han desarrollado otros métodos que implican la secuencia de
deformacion-recristalizacion con el fin de lograr una capa superficial con
tamafio de grano ultrafino [86]. Aunque el arenado es el foco principal,
también existen otras técnicas que emplean esta secuencia [26,87,88]. En
esta técnica, las probetas son arenadas y luego recocidas a bajas
temperaturas. La capa superficial impactada esta altamente deformada
plasticamente y, como resultado, presenta una alta densidad de
dislocaciones. Tras el proceso de recocido, se obtiene una estructura con
nanogranos en la superficie. Un ejemplo es el estudio realizado por Wang
et al.[89], quienes demostraron la generacion de una capa superficial
nanocristalina en acero inoxidable AISI 304 mediante arenado con granos
de silice de 0,21-0,30 mm, seguido de un recocido a 350 °C durante 1 hora.
Este proceso produjo granos menores a 20 nm, mejorando
considerablemente la resistencia a la corrosion y las propiedades mecéanicas
del acero.

A pesar de las ventajas que ofrece esta técnica, ninguna de las
metodologias mencionadas anteriormente resulta compatible con los
procesos industriales, ya que, sus velocidades de operacion son
considerablemente bajas. Esta limitacion principal dificulta su aplicacion en
superficies mas extensas y plantea desafios significativos para la ampliaciéon
del tamafio de las piezas, incluyendo la longitud y el area de la seccion

transversal.

Para superar estos desafios y abordar las limitaciones que enfrentan los
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meétodos convencionales de nanoestructuracion superficial en términos de
aplicabilidad industrial, hace unos afios atras, se planted una soluciéon
experimental e innovadora en el Departamento de Ingenieria de Materiales
de la Universidad de Concepcidn [90]. Esta propuesta involucra un proceso
de laminado en frio de numerosas pasadas con bajas reducciones utilizando
rodillos rugosos y posteriormente, un recocido a baja temperatura. Esta
secuencia de operaciones simula las deformaciones superficiales que se
obtienen mediante técnicas como el arenado, y pretende generar una densa
y compleja marafia de deformaciones superficiales, actuando como
“infinitos” centros de nucleacién durante el subsiguiente recocido a baja
temperatura. Con este enfoque, se busca potenciar las caracteristicas
superficiales, refinando el tamafio sélo a nivel superficial del material sin
comprometer las propiedades internas. Es importante destacar que esta
propuesta difiere significativamente del convencional proceso de laminacion
en frio-recocido, donde se logra una recristalizacion uniforme no

nanométrica en toda la masa o volumen del material.

El resultado preliminar que se obtuvo fue promisorio, en el sentido que se
obtuvieron granos superficiales pequefios, de tamafios micro e incluso
nanomeétrico. Sin embargo, para lograrlo se necesitaba una gran cantidad

de pasadas, al menos 10, lo que imposibilitaba su aplicacion industrial.

Sobre la base de esos promisorios resultados preliminares es que se
desarrolla la presente tesis, en la cual, se adopta un enfoque mas profundo
y metodico en la exploracion del proceso propuesto de refinamiento de
grano superficial en superficies metélicas, en este caso un acero inoxidable
316 L. El método propuesto consiste en una laminacion en frio con rodillos
rugosos con un maximo de 6 pasadas con baja reduccion, seguida de un
recocido por una hora a bajas temperaturas, entre 200 y 400°C, de modo de
poder hacerlo factible desde el punto de vista industrial. Para lo anterior se

combina enfoques experimentales con herramientas de simulacién
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avanzadas mediante elementos finitos. Esta convergencia de metodologias
busca proporcionar una comprension integral de los procesos involucrados
y permitir su control mas preciso, optimizando el niumero de pases, la
microestructura superficial y su correlacion con variables del proceso como

rugosidad de los rodillos y el campo de deformaciones superficiales.

1.1 Hipotesis

e Mediante la laminacién en frio con baja reduccion utilizando rodillos
rugosos es posible generar ‘“infinitos” centros de nucleacion,
promoviendo la formacién de micro o nano granos superficiales
durante el posterior recocido a baja temperatura, manteniéndose

intactas las propiedades hacia el interior del material.

e Es posible definir parametros operacionales claves del proceso, tales
como numero de pases y rugosidad de los rodillos desde el punto de
vista experimental y refrendarlos, retroalimentarlos y optimizarlos

sobre la base de la simulacion numérica del proceso.

1.2 Objetivo general

Desarrollar un nuevo proceso rapido, de alta productividad y aplicable a
grandes superficies que mejore las propiedades de materiales metalicos a
través de la generacion de una capa superficial de micro/nano granos
mediante laminacion en frio con rodillos rugosos seguida de un recocido a

bajas temperaturas.
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1.3 Objetivos especificos

Generar nanoestructuras superficiales en materiales metalicos
mediante laminacién en frio con rodillos rugosos y un posterior

tratamiento térmico.

Investigar el comportamiento mecanico de las piezas, mediante la

caracterizacion de las superficies de las piezas.

Simular el proceso mediante elementos finitos, con el fin de estudiar
sus caracteristicas mecanicas asociadas y correlacionarlo con la

evidencia experimental.
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CAPITULO 2

MARCO TEORICO

En este capitulo, se abordan las caracteristicas de los aceros inoxidables
austeniticos y se exploran conceptos relacionados con el proceso
propuesto, con un enfoque especial en el refinamiento de grano y las

propiedades mecéanicas asociadas.

2.1 Acero Inoxidable austenitico 316L

El acero inoxidable 316 L es uno de los materiales mas utilizado en el campo
de las ingenierias debido a su excelente resistencia a la corrosion, fuerte
resistencia a la oxidacion y buena conformabilidad, sin duda este inoxidable
constituye una importante clase dentro de la familia de los aceros y

aleaciones [91-93].

2.1.1 Composicion y caracteristicas del Acero Inoxidable

El acero inoxidable es una aleacion basada en hierro que presenta un
significativo contenido de cromo y niquel. Se distinguen tres categorias
principales de aceros inoxidables: austeniticos, ferriticos y martensiticos,

cada una caracterizada por su microestructura unica.
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Los aceros inoxidables austeniticos se caracterizan por tener austenita
(hierro en fase gamma) como fase primaria, y su composicion incluye cromo
y niquel, ocasionalmente acompafiados de manganeso y nitrdgeno. Dentro
de la serie 300, los aceros inoxidables de tipos 301 a 304, 316 y 347 son
algunos ejemplos mas reconocidos en el ambito de la ingenieria debido a
sus excepcionales propiedades. Estos tipos de acero son ampliamente
utilizados gracias a su tenacidad, durabilidad, soldabilidad, resistencia a la
corrosion y eficiencia en los procesos de fabricacion. Su eleccion se
sustenta en su capacidad para cumplir con los rigurosos requisitos de
aplicaciones, consolidandolos como materiales de preferencia en el ambito
ingenieril como aplicaciones biomédicas hasta el petroquimico y entornos
de alta temperatura.[94].

La composicion quimica de los aceros inoxidables austeniticos del tipo
316L, se rige por las normas internacionales ASTM A240 o ASTM A276. En
la Tabla 1 se presenta la composicion quimica nominal de este acero en
base a la norma ASTM A240, la cual, especifica los requisitos quimicos y
mecanicos para placas, laminas y bandas de acero inoxidable. Esta aleacién
se compone principalmente de hierro, cromo (16-18%), niquel (10-14%),
molibdeno (2-3%), y cantidades limitadas de carbono (< 0.03%), entre otros
elementos. Los aceros austeniticos pueden endurecerse por deformacion,

pero no por tratamiento térmico.
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Tabla 1. Composicion quimica nominal del acero inoxidable 316L

Elemento Porcentaje en peso
C méx. 0.03
Cr 16.00-18.00
Ni 10.00-14.00
Mn max. 2.00
Si méax. 1.00
P max. 0.045
S max. 0.03
Mo 2.00-3.00
Fe Balance

2.1.2 Estructura

Como se observa en la Tabla 1, el acero inoxidable 316L contiene entre un

16%-18% de cromo. El cromo esta presente en este tipo de aleaciones con

el proposito principal de generar una capa superficial protectora de Cr20s,

comunmente conocida como pelicula pasiva. Esta pelicula desempefia un

papel crucial al proporcionar una notable resistencia a la corrosion. La

Figura 1 [95] presenta el diagrama de equilibrio hierro-cromo [96].
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Figura 1. Diagrama de equilibrio hierro-cromo.

Al observar la Figura 1, podria parecer que un contenido de cromo tan
elevado convertiria completamente la aleacion en ferrita. Sin embargo, este
efecto se contrarresta principalmente gracias al niquel [97]. La Figura 2
muestra un diagrama de equilibrio del sistema binario Fe-Ni que ilustra este
comportamiento, y contrasta notablemente con el del cromo. A medida que
aumenta la concentracion de niquel, el rango de formacién de austenita se
expande. De manera logica, el niquel se considera un estabilizador de la
austenita. Similar al niquel, el manganeso y el nitrégeno también amplian la

region donde puede formarse la austenita.

La adicion de nitrégeno como elemento de aleacién en aceros inoxidables
no solo eleva su resistencia mecanica, sino que también contribuye a
mejorar su resistencia a la corrosion. De manera similar, las inclusiones de
molibdeno ejercen un efecto beneficioso, fortaleciendo la capacidad de los

aceros inoxidables para resistir la corrosion por picaduras.
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Figura 2. Diagrama de equilibrio hierro-niquel

2.1.2.1 Precipitacién de Carburos y Nitruros en Aceros Inoxidables
Austeniticos

La precipitacion de carburos y nitruros en aceros inoxidables austeniticos
constituye un fendémeno de suma importancia que puede incidir

considerablemente en las propiedades de estos materiales.

Los aceros inoxidables austeniticos, que pueden albergar hasta un 0,15%

de carbono, este Ultimo actuando mas como una impureza que como un

elemento de aleacion, presentan desafios particulares. Aunque el carbono

contribuye al incremento del limite elastico y estabiliza la austenita, su

presencia puede generar complicaciones si no se mantiene en solucion
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solida.

Cuando el carbono se aparta de la solucién solida, tiende a combinarse con
el cromo formando M23Cs, donde M consiste principalmente en cromo,
aunque también puede ser hierro. En condiciones especificas de tiempo y
elevada temperatura, los carburos tienden a formarse preferentemente a lo
largo de los limites de grano, dejando areas circundantes con bajos niveles
de cromo. Estas zonas con deficiencia de cromo son susceptibles a la
corrosion, lo que puede resultar en fallos macroscopicos del material,

especialmente en aplicaciones como implantes médicos.

Por esta razén, en el caso del acero inoxidable 316L, se requiere limitar
cuidadosamente el contenido de carbono en la aleacion a niveles bajos, de
ahi la especificacion L (low carbon), con el propésito de prevenir la formacion
de carburos de cromo. La aparicion de estos carburos puede desencadenar

un fenébmeno conocido como sensibilizacion.

La sensibilizacion puede ocurrir durante el enfriamiento lento después de la
soldadura si no se controlan adecuadamente el tiempo y las tasas de
enfriamiento. La cinética de este proceso varia, siendo las aleaciones con
un 0,08% de carbono sensibles en cuestibn de minutos, mientras que
aquellas con menos del 0,03% requieren mucho mas tiempo para
sensibilizarse. El aumento de niquel y molibdeno, asi como el trabajo en frio,
aceleran la precipitacion, mientras que el nitrogeno y el manganeso la

retardan.

Algunas aleaciones estan disefiadas para evitar la precipitacion de carburos
de cromo mediante la formacion preferente de carburos de titanio o niobio.
En aplicaciones de alta temperatura, esta estrategia puede ser mas
adecuada para los austeniticos, mientras que es el método convencional en

los aceros inoxidables ferriticos, donde la reduccion practica de los niveles
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de carbono es dificil.

A temperaturas similares a la de la reaccion de precipitacion de carburos
entre 600 y 1000 °C, pueden precipitar otras fases intermetélicas,
principalmente la fase sigma, en tiempos mas extensos en aleaciones
altamente aleadas con mas del 18% de equivalentes de cromo y bajos
niveles de carbono disuelto. Estas fases son de mayor importancia en las
calidades ferriticas, donde su formacion es aproximadamente 100 veces
mas rapida.

2.1.2.2 La fase sigma o

Debido a su significante influencia, la fase sigma ha sido estudiada por
mucho tiempo por un gran numero de autores. La precipitacion de la fase o,
ocurre de forma comuan en diversas series de aceros inoxidables y constituye
una de las principales causas del deterioro de sus propiedades, incluyendo

las mecanicas, la resistencia a la corrosion y la facilidad de soldadura.

La fase sigma, comunmente definida como Fe-Cr, es un compuesto
intermetélico que contiene aproximadamente un 30-50% de cromo, aunque
también puede disolver cantidades significativas de niquel y otros
elementos. Su formacion se produce en el rango de temperaturas de 600°C
a 1000 °C, dando lugar a un constituyente extremadamente duro y
guebradizo.

La fase sigma es reconocida por sus efectos perjudiciales en las
propiedades mecanicas de los aceros inoxidables, manifestandose en un
aumento de la dureza y una reduccion de la tenacidad y ductilidad. Su
formacion proviene de la transformacion de la ferrita ® en regiones con alta
concentracion de cromo. Esta transformacion se explica por la naturaleza

estabilizadora del cromo en la ferrita, lo que resulta en una mayor
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concentracion de cromo en la ferrita en comparacion con la austenita.
Ademas, la difusion del cromo es mas eficiente en la ferrita que en la

austenita [98].

Cabe destacar que la fase sigma también puede precipitarse a partir de la
y-austenita, especialmente en situaciones donde no se forma &-ferrita en los

aceros inoxidables, aunque este escenario es poco probable [98].

2.1.3 Procesamiento

El procesamiento también ejerce influencia sobre las propiedades
mecanicas de los aceros inoxidables. A diferencia de los métodos
convencionales empleados para modificar las propiedades mecanicas de
otras aleaciones basadas en hierro, como el envejecimiento durante el
tratamiento térmico, estos no son aplicables directamente a los aceros
inoxidables austeniticos. En su lugar, se recurre a mecanismos de
fortalecimiento del material, siendo el mas comun el endurecimiento por

deformacion, también conocido como "trabajo en frio".

El endurecimiento por deformacién implica la aplicacion repetida de
esfuerzos mecéanicos a un material sin calentamiento previo. Este proceso
induce la introduccién de dislocaciones en respuesta a la tensién mecanica
aplicada. Con el aumento de la cantidad de dislocaciones, su movimiento se
ve obstaculizado, ya que interactian en mayor medida dentro del material.
A medida que el material contina deformandose bajo la tension mecénica,

las dislocaciones aumentan en los granos de la aleacion.

A medida que se incrementa la cantidad de trabajo en frio, se observa un
aumento en los parametros de resistencia, como el limite elastico y la
resistencia a la rotura, asi como en la dureza, al tiempo que la ductilidad

tiende a disminuir. La Tabla 2 [94] presenta las propiedades aproximadas de
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aceros inoxidables 316L producidos en diversas condiciones.

En el caso de procesos de deformacion a altas temperaturas, tipicas en la
fabricacion a gran escala de productos metalicos, o cuando el material se
recalienta por encima de su temperatura de recristalizacion después de la
deformacion, las dislocaciones se eliminan mediante la formacion de nuevos

granos recristalizados.

Tabla 2. Propiedades mecanicas estandar del acero inoxidable 316L

L Esfuerzo Esfuerzo de
Condicion del o . »
. maximo fluencia %Elongacion
material
(MPa) (MPa)
Recocido. 550 240 55
30% Trabajo
) 896 827 20
en frio
60% Trabajo
] 1240 1000 12
en frio

2.1.3.1 Martensita inducida por deformacion

Ademas del endurecimiento por deformacion y el alargamiento de los
granos, la deformacion en frio puede conducir a la formacion de martensita.
Este fenOmeno se encuentra intrinsecamente vinculado a la composicion

guimica, la temperatura de deformacion y otros factores.

La transformacion de austenita a martensita durante la deformacién en frio,
por ejemplo, la laminacién, puede ser empleado para mejorar la resistencia
de los aceros inoxidables austeniticos [99]. No obstante, este procedimiento
puede acarrear la anisotropia de las propiedades mecdanicas[100], afectar
negativamente la resistencia a la corrosion [101] y alterar las propiedades
magneéticas[102]
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La formacién de martensita durante la deformacién es responsable de
incrementar el endurecimiento por deformacion. Fendmeno conocido como
plasticidad inducida por transformacion (TRIP). Este efecto es fundamental
para determinar las propiedades mecanicas de los aceros inoxidables

austeniticos metaestables[103].

Asimismo, dentro de los procesos de refinamiento del grano asociado con
la deformacion en frio y recocido, se encuentra la martensita inducida por
deformacion, seguida por su transformacion inversa a austenita de grano
fino durante el recocido. Este proceso, conocido como SIMRT
(Transformation-Induced Microstructure Reversion and Transformation),

puede clasificarse como un proceso termomecanico de martensita [104].

2.2 Refinamiento de grano

El tamafio de grano se puede considerar un factor microestructural crucial
gue influye en practicamente todos los aspectos del comportamiento fisico
y mecénico de los metales policristalinos, asi como en su respuesta quimica
y bioquimica al entorno circundante. Por lo tanto, el control del tamafio de
grano ha sido reconocido durante mucho tiempo como una estrategia
fundamental para disefiar materiales con las propiedades especificas que

se desean obtener [35,105-108].

Un material con grano fino es mas duro y resistente que uno cuya estructura
este compuesta de granos gruesos, puesto que el primero tiene un area total
de limite de grano mayor para impedir el movimiento de las dislocaciones.
En muchos materiales, el limite elastico exhibe una variacion que se ajusta
a la conocida ecuacion de Hall-Petch [109]. Este fendbmeno se atribuye al
incremento en la resistencia del material como consecuencia de la
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microestructura que bloguea el movimiento de las dislocaciones entre los
limites de grano en materiales policristalinos. En otras palabras, la
resistencia del material aumenta a medida que las dislocaciones se

acumulan en la interfaz entre los granos [50,109].

La clasificacion del tamafio de grano en materiales suele dividirse en tres
categorias: nanocristalino (NC), materiales de grano ultrafino (UFG) y
materiales de grano grueso. Diversas investigaciones han establecido de
gue los materiales nanocristalinos (NC) suelen tener un tamafio de grano

inferior a 100 nm.[110].

Cuando el tamafio de grano disminuye a diametros inferiores a 100 nm, en
el rango nano cristalino, la acumulacion de dislocaciones apenas se
produce, lo que invalida la clasica ecuacion de Hall-Petch como una
descripcion efectiva del flujo de plastico [109]. En consecuencia, nuevos
mecanismos de fortalecimiento se han estudiado, donde se ha propuesto
que los materiales exhiben una relacion lineal de dicha ecuacion (relacion

entre limite elastico/dureza y tamafio de grano) en este rango [50].

Cuando el tamafio de grano disminuye por debajo de los 10 nm, se
manifiesta una relacion inversa, comunmente denominada relacién Hall-
Petch inversa. En este contexto, la resistencia de los materiales comienza a
disminuir. No obstante, a esta escala, los mecanismos especificos
relacionados con los limites de grano que son responsables de la
disminucién en la resistencia aun no se comprenden completamente

[111,112].

2.2.1 Métodos para producir refinamiento homogéneo de grano en toda
la masa

Dado que los aceros bajo estudio no experimentan transformaciones de fase
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significativas durante el enfriamiento, las técnicas de deformacién plastica
severa (SPD) y los procesos de recristalizacion se implementan de manera
habitual para lograr el refinamiento estructural y potenciar las propiedades
mecanicas [113].

Las técnicas de SPD, como el prensado angular de canal igual [114], la
torsion a alta presion [115], la forja multidireccional [116], laminacion
acumulativa [117], y la friccibn por agitacion [118], han demostrado ser
exitosas en la obtencion de un refinamiento extremo del grano en los aceros

inoxidables austeniticos.

De acuerdo con lo visto en la seccion anterior, dentro de los procesos de
refinamiento del grano asociado con la deformacion en frio y recocido, se
encuentra la martensita inducida por deformacién, seguida por su

transformacion inversa a austenita de grano fino durante el recocido [99].

Un ejemplo es el estudio realizado por Souza et al., quienes obtuvieron
granos ultrafinos en un acero inoxidable AISI 201, el cual fue laminado hasta
un 60% de reduccion y luego recocido entre distintos intervalos entre 500°C-
800°C. Durante el recocido se observaron los siguientes fenémenos que se
ilustran en la figura: la reversién de martensita a austenita de tamafio de
grano ultrafino, la recristalizacion homogénea en todo el volumen de la
austenita a tamafio micrométrico y el crecimiento de los granos

recristalizados.[102]
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Sin embargo, es importante destacar que, en metales con granos
homogéneos de tamafio nanométrico, se observa una disminucion
significativa de la ductilidad, incluso en metales que son naturalmente
ductiles en su forma de grano grueso, como el cobre y el aluminio. Ademas,
los granos de tamafio nanométrico son térmicamente inestables y tienden a
engrosarse con mayor facilidad en comparacién con los granos regulares de
mayor tamafio. Por ejemplo, en el caso del cobre puro nanoestructurado, se
ha observado engrosamiento del grano incluso a temperatura ambiente

[119].

Estas limitaciones en la estabilidad mecénica y térmica representan
desafios significativos para los materiales nanoestructurados, lo que

complica su procesamiento y sus aplicaciones tecnoldgicas.

Es por esta razon que, en las Ultimas décadas, la investigacion sobre el
refinamiento de grano se ha centrado especialmente en las regiones
superficiales de los materiales. Esto se debe, en parte, al hecho de que, en
la mayoria de las situaciones, los dafios o los esfuerzos maximos tienden a

manifestarse predominantemente en estas areas. Como respuesta a esta
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observacion, se ha desarrollado un enfoque especifico que se concentra en
la formacién de capas de grano fino o ultrafino exclusivamente en la

superficie de los materiales.

2.2.2 Refinamiento del grano superficial

Mediante el refinamiento del grano superficial, se busca mantener una
estructura de grano grueso en el interior de la pieza, creando asi una
disposicion heterogénea en términos de tamafo de grano a lo largo del
espesor del material. Esta estrategia no solo apunta a mejorar las
propiedades mecanicas y de resistencia en las capas superficiales, sino que
también reconoce la importancia de mantener ciertas caracteristicas
estructurales en el nicleo del material. En consecuencia, se forma una
estructura compuesta que optimiza tanto la resistencia superficial como las
propiedades internas, contribuyendo asi a un rendimiento mejorado y mas

equilibrado del material en su conjunto.

Para lograr un refinamiento de tamafio de grano a nivel superficial en
aleaciones o metales, existen un gran nimero de técnicas que han sido

desarrolladas y bien establecidas.

Dentro de los métodos mas utilizados para estos propdsitos se encuentran
los procesos de deformacion plastica severa en cercanias de la superficie o
por sus siglas en inglés, near surface severe plastic deformation (NS-SPD).
Algunos ejemplos de esta técnica incluyen el granallado severo [74,75], el
granallado ultrasénico [66,76,77], el granallado de alta energia [78,79], la
atricion mecanica superficial [80,81], el granallado de impacto ultrasénico
[82,83] y oOtros [84,85].
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En todas estas técnicas mencionadas, la capa superficial superior
experimenta una deformacion plastica severa a altas velocidades de
deformacion. Cuando se utilizan altas velocidades de deformacion, ademas
de generar la deformacion de los granos, puede ser propicio para la

formacién de maclas o formacién de martensita [120].

Sobre la base de los conocimientos del proceso de recristalizacion, algunos
investigadores han optado por seguir la secuencia deformacion severa en

las cercanias de la superficie seguido de un recocido de recristalizacion.

Esta secuencia, ademéas de ser exitosa en la generacién de esta capa
superficial nanoestructurada, también hace posible un aumento en el
porcentaje de elongacién de las piezas que se someten al recocido luego
de la deformacién superficial. Ademas, abre las puertas, a un posible control
del tamafio de grano final a través de los clasicos conocimientos de
recristalizacion haciendo uso del control de tiempo-temperatura del

tratamiento térmico.

Dentro de los procesos mas investigados que hacen uso de esta secuencia

se encuentran el arenado y la atricion mecéanica superficial, entre otros.

A pesar de los numerosos esfuerzos dedicados a la investigacion de las
estructuras de estos procesos en los aceros inoxidables 316L, aun persisten
discrepancias en cuanto al mecanismo de refinamiento de grano. Gubicza
et al. [115] han informado que, durante el proceso de deformacion severa por
prensado a alta presion, se produce una transformacién de fases de la
austenita a la martensita, y que el recocido posterior a esta deformacion
extrema podria dar lugar a la formacion de granos de austenita mas
pequefios. Por otra parte, Liu et al. [121] llegaron a la conclusién de que el
mecanismo de refinamiento del grano inducido por el granallado mediante

pulsos ultrasonicos podria estar relacionado con una elevada densidad de
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dislocaciones y la formacion de pequefias bandas de corte.

Agrawal et al. [122] han proporcionado avances detallados sobre la
formacion de nanogranos en las superficies de acero inoxidable 316L a altas
velocidades de deformacion de 7.7x10%? Las observaciones
microestructurales de las capas superficiales tratadas con la técnica de
tratamiento superficial indicaron que los procesos de refinamiento del grano
en estos aceros inoxidables involucraban la formacion de maclas de

deformacion incluso a bajos porcentajes de deformacion.

Se puede concluir que existen mecanismos de deformacién plastica de
microestructuras muy diferentes, fenbmenos que no ocurren en sus

contrapartes homogéneas.

Para finalizar, en lo que respecta a las técnicas para la hano estructuracion
de superficies, ademas de aquellas que utilizan deformacion plastica,
existen otras técnicas que merecen ser mencionadas. Algunas de estas
técnicas incluyen la modificacion de superficies mediante el uso de laser

[123], procesos de carburizacion [124] y, entre otros.

2.3 Propiedades Mecéanicas

Cuando un material con tamafio de grano homogéneo se deforma, la
deformacion plastica se produce simultdneamente en diferentes granos, lo
gue produce tensiones intergranulares entre granos adyacente que no se
pueden deformar en conjunto. Sin embargo, cuando la estructura de grano
se vuelve mas fina en la superficie, la deformacion comienza en los granos
gruesos y los granos mas pequefios se deforman solo cuando la carga
aumenta. Es decir, la deformacion plastica se propaga desde las regiones

de grano grueso a los granos mas finos progresivamente, hasta que alcanza
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la capa nanoestructura. Las tensiones intergranulares entre los granos
vecinos de diferentes tamafos se liberan de manera efectiva y se suprime
la localizacion de estas tensiones, lo que permite que la capa
nanoestructurada realice deformaciones plasticas al mismo tiempo que las
otras partes de la muestra, esto conduce a una marcada mejora en las
propiedades mecéanicas del metal, lo que incluye no solo la resistencia al
desgaste, sino también la dureza, la tenacidad y la resistencia a la fatiga,
entre otras. Esta optimizacién en las propiedades mecénicas se debe al
mayor numero de limites de grano y a la reduccion en la migracion de

dislocaciones en la microestructura.

2.3.1 Durezay resistencia al desgaste

Los materiales metalicos nanoestructurados, con sus estructuras nano
cristalinas 'y granos ultrafinos, exhiben propiedades mecanicas
excepcionales, lo que los convierte en opciones altamente atractivas para

una amplia gama de aplicaciones.

En lo que respecta a su resistencia al desgaste, la ley clasica de Archard,
sefiala que la resistencia al desgaste de un material guarda una relacion
directa con la dureza de su superficie. Estudios han demostrado que la
resistencia al desgaste de materiales con granos de tamafio nanométrico

supera en gran medida a la de aquellos con granos mas gruesos [125].

En particular, cuando la estructura de grano se afina superficialmente se
produce una mejora significativa en las propiedades mecénicas del metal,
tanto en lo que respecta a su superficie como al sélido en general, incluso
si solo la capa superficial esta nanoestructurada. Se ha observado un
aumento sustancial en la resistencia al desgaste en varios metales y

aleaciones que presentan capas superficiales nanoestructuradas [126],
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debido al endurecimiento significativo de su superficie [127,128].
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CAPITULO 3

MATERIALES Y METODOS

En este capitulo se brinda informacion detallada acerca de los materiales
utilizados y las metodologias aplicadas en el presente estudio. Se incluye
una descripcion del proceso de preparacion de las muestras, asi como su
posterior caracterizacion, que comprende la evaluacion de sus propiedades

y el andlisis matematico correspondiente.

3.1. Experimental

3.1.1 Material

Considerando los resultados exitosos de investigaciones anteriores y la
amplia documentacion disponible sobre procesos de nano estructuraciéon
superficial en aceros inoxidables, se determind que el AISI 316L seria la
eleccion mas adecuada como material base para este estudio de tesis. Las
placas utilizadas tenian un espesor inicial de 5 mm, y la composicion
guimica nominal del material se encuentra regida por las normas ASTM
A240 y ASME SA-240; los detalles de esta composicién se presentan en la
Tabla 1.
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Para asegurar una estructura inicial uniforme y eliminar eventuales
esfuerzos residuales las laminas, se sometieron previamente a un proceso
de normalizacién a una temperatura de 900°C, temperatura reportada en
estudios sobre arenado en aceros 316L, durante un periodo de 2 horas. Una
vez completado el tratamiento térmico de normalizacion, se dio paso al corte
de las placas en dimensiones especificas de 5 cm de ancho x 6 cm de largo,
para facilitar su manipulacién durante el proceso de laminacion y posterior

caracterizacion.

3.1.2 Laminacién y tratamiento térmico

Después de cortar las piezas, estas fueron laminadas en frio, tanto con
rodillos convencionales como con rugosos. Para el nimero totales de pases,
se decidio trabajar con el estdndar para la laminacion en frio de planchas de
aceros de minimo espesor, lo que equivale a un total de 6 pasadas, dando
una reduccion absoluta de 0,5 mm en cada una de ellas. Dado que se busca
generar solo micros o nano granos en la superficie, sin afectacion de la
estructura y propiedades hacia el interior, se requiere utilizar deformaciones
bajas, que induzcan la fuerza impulsora necesaria para la recristalizacion, y
gue se concentren en zonas superficiales. Valores de reduccién relativa
entre 10 y 20% cumplen con ese objetivo, lo que se consigue con una
reduccion absoluta de 0.5 mm al generar 10 y 20% de reduccion relativa en
el primer y sexto pase respectivamente. Esa baja reduccion, ademas de
asegurar solo deformacion superficial, hace poco probable la presencia de
martensita inducida por deformacion en la superficie, y la descarta hacia el

interior, libre de deformacion.

El laminado se llevd a cabo utilizando un laminador reversible Joliot con una

potencia de 7,5 kW, equipado con rodillos de 200 mm de ancho y 127 mm
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de diametro. Para lograr una superficie rugosa en los rodillos, se realizé un
proceso de mecanizado en el cual se generaron piramides de base rémbica
en la superficie de estos. Estas piramides tenian dimensiones de 2,08 mm
de largo, 1,04 mm de ancho y 1,5 mm de alto.

Después de completar el proceso de laminacion, las muestras fueron
sometidas a un tratamiento de recocido de una hora en un horno de mufla
tipo Batch a baja temperaturas de modo de generar micro 0 nanogranos:
200°C, 300°C y 400°C, similares a las reportadas en literatura para otros

procesos de nano estructuracion superficial de aceros.

3.1.3 Caracterizacién morfoldgicay estructural

Para realizar la caracterizacion morfologica y estructural de las muestras

laminadas y recocidas, se llevaron a cabo los siguientes procedimientos.

En primer lugar, se sometieron las secciones transversales de las muestras
a un proceso de desbaste mecanico utilizando papeles abrasivos de SiC
hasta lograr un tamafio medio de rayado de 8 um. Posteriormente, se aplicd
un pulido fino con pasta de diamante y Oxido de aluminio (0,05 pm).
Seguidamente, las muestras se sumergieron en un bafio ultrasénico con
etanol para eliminar cualquier tipo de impureza, ya sea originada durante el
lijado o el pulido. Finalmente, las muestras se secaron y almacenaron en un

desecador para sus posteriores analisis.

Para revelar la microestructura del material, se emple6 un ataque quimico
utilizando una mezcla de acido nitrico y acido clorhidrico en una proporcion

molar de 1:3, conocida como agua regia.

Las primeras observaciones en esta etapa se realizaron utilizando un
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microscopio 6ptico Olympus GX51. Este microscopio se utilizé para estudiar
la microestructura generada por la combinacion de los procesos,

centrandose especialmente en la superficie tratada.

Debido la dificultad en la observacién microscopica debido al desenfoque de
la superficie tratada causado por los bordes irregulares que resultaron del
proceso de lijado y pulido, se recurrié a un microscopio confocal de barrido
laser Olympus LEXT. Este tipo de microscopio permite obtener imagenes de
un solo plano confocal y se basa en la eliminacion de la luz procedente de
planos fuera de foco. De esta manera, es posible obtener resultados incluso
cuando existen diferencias de desenfoque entre la matriz y la superficie.
Asimismo, se utilizé este equipo para comparar la morfologia de la superficie
tratada con rodillos rugosos en comparacioén con rodillos convencionales.
Este andlisis permitié evaluar las diferencias entre las dos condiciones de

procesamiento.

Con el propésito de analizar el tamafio de grano en la capa cercana a la
superficie de las muestras, se empleé un método de ataque quimico
electrolitico. Este método consisti6 en sumergir las muestras en una
solucion compuesta por acido nitrico al 60% mezclado con agua al 40%, a
una corriente eléctrica de 8-9 A/cm2 durante un periodo de 120 segundos.
Esta técnica permite revelar los limites de grano sin mostrar las maclas de

recocido, lo que facilita la determinacion precisa del tamafio de grano.

Las imagenes electronicas de barrido se obtuvieron utilizando un
microscopio VEGA3 TESCAN con una energia de 20 kV. Este enfoque
proporciona una visualizacion detallada de la estructura de grano y permite
un analisis preciso del tamafio de grano en la capa superficial de las

muestras.
Ademas, se realizé un analisis EBSD en un microscopio electronico de
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barrido Hitachi SU-70 con un sistema EDAX y el software de analisis OIM-
TSL.

3.1.4 Resistencia al desgaste y caracterizacion por nanoindentacion

Para evaluar la resistencia al desgaste, se realizé un ensayo en condiciones
no lubricadas utilizando un tribdbmetro TYPE TRM 1000. Durante las pruebas
de desgaste, se aplicO una carga constante de 30 N, se mantuvo una
velocidad de desplazamiento de 0,1 m/seg y se recorrié una distancia de
200 metros. Para analizar el mecanismo responsable del desgaste
observado en la superficie expuesta, se empled la técnica de imagen

electronica secundaria en un microscopio electrénico de barrido (SEM).

Para determinar la dureza en funcién de la profundidad desde la superficie
hacia el interior del material, se llevé a cabo un ensayo de nanoindentacién
utilizando un nano tribo indentador Hysitron Tl Premier. Se empled una
punta de diamante Berkovich y se aplico la técnica de carga, retencion y
descarga para obtener las durezas a diferentes profundidades. Cada
indentacion se realiz6 mediante tres ciclos de carga-mantenimiento-
descarga (25 segundos de carga, 5 segundos de mantenimiento y 2
segundos de descarga) utilizando el modo de control de carga y una carga
aplicada de 5000 pN.

Estos ensayos proporcionaron informacion sobre la resistencia al desgaste

del material y su dureza en diferentes profundidades.

3.2. Método de elementos finitos

Con el propoésito de examinar el campo de deformaciones, esfuerzos y
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fuerza de laminacion, se llevo a cabo un analisis del proceso mediante el
meétodo de elementos finitos empleando el software Simufact 19.0, al cual
se pudo acceder gracias a facilidades dadas por la Universidad de Nueva
Ledn, México. Los resultados obtenidos ademas fueron complementados
con el software Ansys R2 2020 de la Universidad de Georgia, Estados

Unidos, comparando esfuerzos y deformaciones Unicamente.

3.2.1 Software Simufact

3.2.1.1 Aspectos béasicos

En este software, las ecuaciones fundamentales se integran en el tiempo
mediante un procedimiento dinamico explicito. Todas las variables en las
ecuaciones fundamentales se evallan en un esquema de integracion
temporal Runge-Kutta. El sistema completo de ecuaciones se resuelve al
separar los flujos de difusibn y conveccién respectivamente. Hay tres

ventajas al utilizar este enfoque:

e Evitar la no linealidad debida a los términos de conveccioén al evaluar

el impulso.
e Estabilizar los célculos numéricos.
e Simplificar la implementacion.

Ademas, no se emplea ninguna iteracién para la interaccion entre pasos,

debido al pequefio paso de tiempo en el método explicito.

La ley de conservacion del momento se expresa en forma integral de

volumen como:
ovi 1

E(’)V = E_Lo-ijnjds
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Donde nj es el vector normal unitario en el limite S del elemento de volumen

finito.

Los valores en las caras del elemento de volumen finito se obtienen
resolviendo el problema de Riemann. Con esto, la nueva velocidad en el
elemento de volumen finito se actualiza. La ley de conservacion de la

energia se expresa en forma integral de volumen como:
de )
P EdV— O-ijgijdV: —fhinidS
v 14 N

La solucién de esta integral proporciona un nuevo campo de temperatura,
afectado por el calor generado a partir de la deformacion plastica, la
conduccion de calor dentro del material y la transferencia de calor desde la

superficie.

La nueva velocidad actualizada se utiliza para calcular el flujo de material de
un elemento de volumen finito a otro. EI material transporta consigo las
propiedades correspondientes (tensién/deformacion, energia,
caracteristicas del material, etc.). Este flujo de conveccién se calcula sin
cambiar el valor de las cantidades fisicas que se transportan con el material.
Esto elimina el término de divergencia, y las leyes de conservacion de masa,
momento y energia se simplifican a:

a(pp) N d(ppv;) _

0
at axl-

Donde ¢ es cualquier cantidad fisica por unidad de masa. La forma integral
utilizada en el paso de adveccion del método de volumen finito se expresa

de la siguiente manera:

]
- | ppdV = — f ppvin; dS
at \%4 S

Una vez que se ha calculado el transporte de masa, se actualiza la nueva
densidad en cada elemento de volumen finito. Ademas, el tensor de
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velocidad de deformacion se calcula a partir del incremento de velocidad, de

. 1 avi n 017]
gij B 2 axj axl-

Con este nuevo tensor de velocidad de deformacion, la deformacion se

la siguiente manera:

actualiza. A continuacion, los valores de esfuerzo se determinan a partir de
las relaciones constitutivas elastico-plasticas, que dependen de la
temperatura, la deformacién y la velocidad de deformacion. Ademas,
cuando se activan, las transformaciones de fase y los tamafios de grano se

actualizan segun los nuevos campos de temperatura y deformacion.

3.2.1.2 Geometria del modelo

Respecto a los rodillos, estos se diseilaron con las mismas dimensiones
utilizadas en la parte experimental, mientras que la pieza de trabajo tenia
unas dimensiones de 60 mm de largo, 25 mm de ancho (para acortar tiempo
de procesado) y 5 mm de alto. Ademas, en el analisis se considero friccion
por adherencia segun modelo de Von Mises en el contacto entre el rodillo y
la placa de acero 316L.

Para evaluar la influencia de la rugosidad en la deformacion superficial de
la pieza, se tomaron en cuenta cuatro niveles de rugosidad, que abarcaron
desde una superficie lisa (lograda con rodillos convencionales) hasta
incrementos graduales de rugosidad, abarcando niveles de baja, media y
alta rugosidad. Este enfoque se implement6 con el propdsito de analizar
cémo estos diferentes niveles de rugosidad afectan la deformacion plastica

y otras variables del proceso.

Para simular la rugosidad en la superficie del rodillo, se emplearon piramides
de base cuadrada con distintas dimensiones de longitud y de altura, las
cuales se muestran en la Tabla 3, testeadas en formas sucesivas en el
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tiempo. Rugosidades mayores de 1 mm no pudieron utilizarse debido a
posteriores restricciones por parte de las autoridades mexicanas al uso del
programa para estudiantes extranjeros. La Figura 4a muestra la superficie
del rodillo utilizada en el andlisis experimental, mientras que la figura 4b

ilustra la superficie creada mediante un software de disefio.

Tabla 3. Rugosidad simulada en la superficie de los rodillos utilizada en

ambos softwares, Simufact y Ansys.

Rugosidad Altura (mm) Largo (mm)
Baja 0.1 15
Media 0.25 2.5
Alta 1 2.5

(@) (b)

Figura 4. Superficie del rodillo a) experimental y b) simulada

Para caracterizar el comportamiento mecanico del acero inoxidable 316L,

se utilizaron curvas de esfuerzo deformacion obtenidas mediante el software

MatlLDa®, que esta integrado en el software Simufact. En la Figura 5, se

representa la relacion entre el esfuerzo y la deformacion plastica efectiva a

una temperatura de 20 °C para el grado de acero 316L que se encuentra
38



bajo estudio.

Este material, se encuentra definido en la base de datos del software con el
nombre: DB.316L_baseplate. La norma DIN 1.4404 define la composicién
guimica de este acero, siendo la siguiente: C=0.009, Cr=16.82, Cu=0.31,
Mn=1.74, M0=2.08, N=0029, ademas permite un amplio rango de trabajo,
entre 20°C-1400°C.
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Deformacion plastica efectiva

Figura 5. Curva de flujo de esfuerzo del acero inoxidable a 20°C

La Figura 6 representa el modelo de elementos finitos utilizado para simular
una pasada de laminacion. Este modelo considera una alta rugosidad en la
superficie de los rodillos y proporciona una representacion visual detallada
de como se produce la deformacion y la interaccién entre los rodillos y la

pieza de trabajo durante el proceso de laminacion.
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(@) (b)

(c)

Figura 6. Configuracion geométrica del modelo FEM mediante Simufact, a)

vista general, b) abertura rodillos, ¢) malla

3.2.2 Software Ansys

Con el objetivo de poder cotejar los resultados obtenidos a través del
software Simufact, se llevd a cabo un estudio comparativo utilizando el
software Ansys. Es importante destacar que, a pesar de su utilidad en el
analisis mediante elementos finitos, estos dos softwares presentan algunas
diferencias significativas en cuanto a su enfoque y capacidades.

Simufact se destaca por su enfoque especializado en la simulacién de
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procesos de fabricacion, lo que lo hace particularmente efectivo para
analizar fendmenos relacionados con la produccion y deformaciones
plasticas en materiales. Su interfaz y capacidades estan disefiadas para
satisfacer las necesidades especificas de la industria manufacturera, es
decir, es muy pertinente al proceso propuesto en esta tesis. Algunos detalles

de las interfases de este modelo se encuentran en anexo A.

Por otro lado, Ansys es un software de simulacidbn multipropdsito
ampliamente utilizado en diversas disciplinas de ingenieria. Ofrece una
amplia gama de médulos y herramientas para el analisis estructural, térmico,
fluidodinamico y electromagnético, entre otros. Su versatilidad lo convierte
en una eleccion preferida en campos mas generales de ingenieria, y puede
adaptarse a una variedad de aplicaciones. No es un software estrictamente
especializado en conformado de metales. Los detalles de algunas de sus

interfases se encuentran en anexo A.

En el a&mbito de la simulacion de procesos de laminacion, Simufact se
destaca como una opcién generalmente reconocida por su mayor precision
y especializacion en comparacion con Ansys. En particular, destaca en
Ansys la dificultad en modelar friccidbn de tipo adherente, por lo que se
espera que las comparaciones entre ambos métodos sean aceptables solo

en cuanto a deformaciones se refiere.

Por lo sefalado, solo se simulé Ansys para la primera pasada de laminacion
utilizando rodillos convencionales y de rugosidad media, utilizando un
coeficiente de friccion 0,45, insuficiente para asegurar friccion adherente.en
un entorno de la entrada y salida de la zona de deformacion, pero excesivo

respecto a las zonas centrales de dicha zona.

Las dimensiones del material y condiciones de laminacién segun modelo

Ansys se encuentran detallados en la Tabla 4. Para abordar el analisis

41



estructural, se recurrio al uso de ecuaciones constitutivas elastico-plasticas
a fin de describir el comportamiento del material bajo estudio y se seleccioné
un modelo de endurecimiento isétropo bilineal, tal como se ilustra en la
Figura 7. Los valores de las propiedades utilizadas en este modelo se
encuentran detallados en la Tabla 5. Estas propiedades corresponden a las
del acero inoxidable que estan disponibles en la biblioteca del software
extrapoladas a las trabajadas en Simufact. Para la muestra de acero
inoxidable, se consider6 un comportamiento elastico-plastico, mientras que,

para los rodillos, se asumio un material rigido.

Con el propdsito de optimizar el modelo y considerando la simetria inherente
al proceso, se eligio representar solamente la mitad de la configuracion. La
eleccién del plano de simetria se efectu6 a lo largo del corte longitudinal-
medio de la pieza modelada, y se aplicaron las condiciones de contorno

pertinentes de manera precisa.

Tabla 4. Dimensiones fisicas (mm) de la pieza y los rodillos de laminacion

modelo utilizando el software Ansys

Dimensioén Valor

Ancho 25

Lamina Espesor 5
Largo 60
Diametro 127

Rodillo

Ancho 200
Abertura rodillos 45
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Tabla 5. Propiedades mecanicas de la pieza utilizadas en el modelo

utilizando software Ansys.

Propiedad Magnitud
Moédulo de Elasticidad 193 GPa
Coeficiente de Poisson 0.3

600 4

450

300

Esfuerzo (MPa)

150

T T :
0,000 0,004 0,008 0,012
Deformacion

Figura 7. Modelo bilineal curva esfuerzo-deformacion del acero inoxidable,

modelo Ansys
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(€)

Figura 8. Configuracion geométrica del modelo FEM mediante Ansys, a)

vista general, b) abertura rodillos, c) malla
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CAPITULO 4

RESULTADOS

En este capitulo se presenta los resultados relevantes de la investigacion y

su andlisis correspondiente.

4.1 Experimental

4.1.1 Anélisis microestructural

Las Figuras 9y 10 presentan las caracteristicas microestructurales del acero
inoxidable austenitico 316L, el cual fue sometido a un proceso de recocido
previo a 900°C durante 2 horas antes de la laminacion. Dada la composicion
guimica de esta aleacion, la microestructura estd compuesta por granos
poliédricos de austenita, tal como se observa en la Figura 9, con un tamafio
de alrededor de 30 um, los cuales pueden exhibir maclas, como se aprecia
en esta imagen. Ademas, se pudo observar la presencia de carburos
complejos en la estructura, y cordones de ferrita delta en la matriz del acero

austenitico.

Respecto a propiedades mecanicas del material base y atingentes a esta

tesis, nano dureza y resistencia al desgaste, se encuentran indicadas en

figuras 18, 21 y 22. En relacion con la nanodureza inicial, en toda la masa
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se tiene un valor cuasi uniforme de 5 GPa. El mecanismo de desgaste de
las muestras recocidas es el tipico correspondiente a materiales ductiles,
del tipo arado y cufa. La profundidad del surco de desgaste es de 100
micrones.

En la Figura 10, se muestran las imagenes obtenidas mediante microscopia
electronica de barrido, utilizando tanto electrones secundarios como
retrodispersados. Estas imagenes confirman un tamafio de grano de
aproximadamente 30 um en la muestra.
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Figura 9. a) Microestructura original del acero inoxidable 316L antes de la

laminacion. b) aumento
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(@) (b)

Figura 10. Imagenes de microscopia electronica de barrido del acero
inoxidable 316L antes de la laminacién utilizando electrones a)

retrodispersados, b) electrones secundarios

La Figura 11 presenta las micrografias utilizando microscopia confocal de
las muestras laminadas con rodillos convencionales después del proceso de
recocido. En la Figura 11a, se aprecia la muestra recocida a 300°C, mientras
gue en la Figura 11b, se presenta la muestra recocida a 400°C, ambas
durante 1 hora. En ambas imagenes, se observan granos recristalizados sin
la presencia de granos deformados en toda la masa del material, lo que
indica que el tratamiento térmico de recristalizacion ha tenido lugar. Notese
gue la baja reduccién y deformacién por pase, descarta la formacion de
martensita, lo que se corrobora con su inexistencia en las micrografias. Por
otra parte, no se observa un refinamiento del tamafio de grano superficial, y
se tiene una distribucion homogénea del tamafio de grano en ambas

muestras, con tamanos similares de alrededor de 30-35 pm.
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Figura 11. Microestructura de las muestras laminadas con rodillos

convencionales y recocidas a: a) 300°C y b) 400°C por una hora.
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En la Figura 12, se presenta una micrografia obtenida a través de
microscopia optica de una muestra que fue laminada con rodillos rugosos y
posteriormente sometida a un proceso de recristalizacion a 300°C durante
1 hora. Se aprecian cambios notables en la microestructura entre el centro
de la pieza y su superficie; no obstante, no es posible realizar una distincion
de granos recristalizados mediante esta técnica. Para superar estas
dificultades, se realizaron andlisis utilizando microscopia confocal. La Figura
13 muestra estos resultados para esta muestra tratada con rodillos rugosos.
Obsérvese que la zona interior de esta muestra (Figura 13a) presenta
granos de tamafo similar a los observados en las muestras laminadas con
rodillos convencionales, la presencia de algunos granos recristalizados en

la matriz se ha resaltado con circulos rojos.

En la Figura 13b es posible observar tanto la superficie como el centro de la
muestra. La presencia de granos recristalizados se ha destacado con
circulos rojos, estos se encuentran en el centro de la muestra. Sin embargo,
al examinar la superficie, s6lo se observa una variacion de tamafio
microestructural en comparacion con la region central y no es posible

dilucidar la microestructura en esta zona.
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Figura 12. Micrografia muestra laminada con rodillos rugosos y recocida a

300°C, zona borde. Ataque quimico agua regia. 500x
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Figura 13. Microestructura de las muestras laminadas con rodillos rugosos

y recocidas a 300°C por una hora. a) matriz y b) cercanias de la superficie

En la Figura 14, se presenta la micrografia de la muestra laminada con
rodillos rugosos y posteriormente recristalizada a 200°C durante 1 hora. Se

observan conclusiones similares a las del caso anterior (Figural3. Donde se
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identifican granos refinados en la superficie. En este caso, se observa que
el tamafio de grano recristalizado en el centro de la muestra es ligeramente
menor al anterior, de aproximadamente 25 um. Esta diferencia puede
atribuirse a la influencia de la temperatura de recristalizacion, mas baja en

esta ocasion.

Es importante sefialar que discernir la presencia de granos ultrafinos o
nanometricos a esta escala de observacion no es factible. Por este motivo,
la Figura 15 muestra la capa superficial de una muestra laminada con
rodillos rugosos Yy recristalizada a 400 °C durante una hora utilizando de la
técnica de microscopia avanzada electronica de barrido. En estas imagenes
es posible observar la presencia de granos recristalizados que miden

aproximadamente 200 nm.
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Figura 14. Microestructura de las muestras laminadas con rodillos rugosos
y recocidas a 200°C por una hora. a) matriz y b) cercanias de la superficie
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()

Figura 15. Imadgenes SEM de una muestra laminada con rodillos rugosos y

recocida a 400 °C durante una hora. a)10.000x, b)25.000x.

La Figura 16 presenta micrografias SEM de la microestructura cercana a la
superficie obtenidas a partir de muestras laminadas con rodillos rugosos y

sometidas a recocido a 300°C y 400°C durante 1 hora.
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En la Figura 16a, se evidencia claramente la presencia de un grano
recristalizado con un tamafio aproximado de 10 ym, encerrado en un circulo
rojo, lo que indica que el proceso de recristalizacién ha ocurrido en esta
zona. Por otro lado, en la Figura 16b, se aprecian granos recristalizados de
menor tamafio en comparacion con la Figura 16a. Granos con diametro de
menos de 1 ym han sido encerrados en circulos amarillos, por otra parte,
granos con un diametro de alrededor de 3 ym, se han encerrados en circulos
rojos. La presencia de estos granos de distinto tamafo, indica la

heterogeneidad en la distribucion del tamafio de grano recristalizado.

Un examen mas detallado de la Figura 16c, especificamente en el area
dentro del circulo rojo, revela la presencia de granos recristalizados con un
tamafio medio de aproximadamente 200 nm. Esto indica que se han
formado nanogranos en la zona cercana a la superficie debido al proceso
de recristalizacion. Sin embargo, la imagen también da muestra de que la
recristalizacion de nuevos granos ocurre de manera heterogénea, lo que
destaca la naturaleza compleja del proceso de recristalizacién en la
microestructura de las muestras laminadas con rodillos rugosos y sometidas

a recocido.
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Figura 16. Imagen SEM muestra laminada con rodillos rugosos y recocida
a)- b) 300°C, c) 400°C, ambas por 1 hora.

En la Figura 17a, se presentan imagenes obtenidas mediante difraccion de
electrones de retrodispersion (Electron Backscatter Diffraction, EBSD) en

regiones cercanas a la superficie, para una muestra laminada utilizando
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rodillos rugosos y recristalizada a 400°C por 1 hora. En estas imagenes, se
puede observar la generacion parcial de nuevos granos recristalizados de
tamafio nanométrico. No obstante, como se observé en las imagenes
previas, la formacion de estos granos parece ser parcial y no uniforme. Este
fendmeno puede atribuirse a la falta de homogeneidad en la deformacién
superficial durante el proceso de laminacion, lo que afecta la recristalizacion

de manera no uniforme en la superficie.

El grafico presentado en la Figura 17b confirma este fenbmeno. En él, se
muestra la relacion entre la fraccion de area y el tamafio de grano. Es
evidente que una gran fraccién de area conserva un tamafio de grano
superior a 1 pum, mientras que los granos de tamafio nanométrico ocupan

solo una pequefa porcién de la fraccion de area.

Estos resultados sugieren que la recristalizacion y la formacién de granos

nanometricos en la zona cercana a la superficie son selectivas y localizadas.

Tamanio de grano (Diametro)

Fraccion de area
g

00
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Tamafio de grano (um)

(a) (b)

Figura 17. a) Imagen EBSD muestra laminada con rodillos rugosos y

recocida a 400°C. b) fraccion de area versus tamafio de grano
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La figura 18, por su parte muestra los resultados obtenidos mediante EBSD,
para una muestra laminada mediante rodillos rugosos y recristalizada a
200°C por 1 hora. Los resultados evidencias nuevamente la distribucion no

uniforme de la microestructura resultante.
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Figura 18. a) Imagen EBSD muestra laminada con rodillos rugosos y
recocida a 200°C. b) fraccion de area versus tamafio de grano

Finalmente, estas observaciones dan cuenta de la influencia significativa de
la utilizacion de rodillos rugosos en el proceso de laminacion en la variacion
del tamafio de grano recristalizado en la superficie, con algunos granos

alcanzando tamanos nanométricos.

Nétese que, de acuerdo con las micrografias correspondientes, en las
muestras laminadas con rodillos convencionales en general toda la
estructura consiste de granos recristalizados de tamafio aproximado 30
micrones. En contraposicion, en las muestras laminadas con rodillos
rugosos, esos granos se observan solo en la zona interna del material. En
su superficie en cambio se inducen granos de menor tamano, tal y como lo

indican las figuras 16 y 17.
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Considerando que la microestructura ejerce un impacto en las propiedades
finales del material, es de importancia tener en cuenta el proceso de
recristalizacion al disefiar y optimizar procedimientos de laminacion que
empleen rodillos rugosos con miras a obtener microestructuras especificas.
En la siguiente seccion se estudia el efecto de las microestructuras

encontradas sobre las propiedades superficiales.

4.1.2. Resistencia al desgaste y analisis de nanodureza

La Figura 19 muestra los perfiles de desgaste obtenidos, representando la
profundidad frente a la anchura de los surcos de desgaste en las muestras.
Las Figuras 19a y 19b muestran los perfiles de desgaste de las muestras
laminadas utilizando rodillos convencionales y rodillos rugosos,

respectivamente, ambas recocidas a 400°C.

Si bien la rugosidad de las muestras laminadas con rodillos rugosos dificulta
la comparacion, se visualiza que la profundidad del perfil del surco de
desgaste es mas pronunciada en la muestra laminada con rodillos
convencionales, cuando se compara con aquella laminada utilizando rodillos
rugosos. Esto se puede observar con detalle en la figura 19c donde se
muestran ambos surcos de desgaste superpuestos. La profundidad del
surco de desgaste causado por la muestra utilizando rodillos convencionales
es de aproximadamente 100 um, mientras que, con rodillos rugosos, el valor
alcanza aproximadamente 75 um. Estos resultados indican que el uso de

rodillos rugosos aumenta la resistencia al desgaste del material.

Por otra parte, la Tabla 6, muestra los resultados obtenidos en cuanto a la
pérdida de masa luego del ensayo. Se da cuenta del mismo resultado, en
los casos en que se utilizaron rodillos convencionales, se tuvo una pérdida

de masa mayor luego de realizar el ensayo.
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Figura 19. Perfiles de desgaste de las muestras recocidas a las 400°C y

laminadas con rodillos a) convencionales b) rugosos c) comparacion entre

ambos.
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Tabla 6. Pérdida de masa (gramos) de piezas sometidas a ensayo de

desgaste
Ensayo Convencional Rugoso
1 0,03 0,019
2 0,028 0,017
3 0,04 0,02
4 0,029 0,014
Promedio 0,03175 0,0175

Las Figuras 20 y 21 presentan imagenes obtenidas mediante microscopia
electronica de barrido (SEM) que ilustran la topografia resultante después
de someter las muestras a la prueba de desgaste. En la Figura 20, se
presenta la imagen del desgaste en una muestra laminada utilizando rodillos
convencionales. Las imagenes muestran zonas con desplazamiento lateral
del metal debido a la deformacién plastica encerradas en circulos rojos, lo
gue corresponde a una mezcla de mecanismos de desgaste, incluyendo
surcos causados por arado y cufia. Este comportamiento es tipico de

materiales ductiles.

Por otro lado, en la Figura 21, se presentan imagenes para muestras que
fueron laminadas utilizando rodillos rugosos y luego recocida a 300°C y
400°C por 1 hora. En la Figura 21a en particular, se observa la muestra que
fue recristalizada a 300°C, es posible apreciar un desgaste caracteristico de
corte, donde no hay desplazamiento de material hacia los lados como en el
surco de arado, ni material acumulado en el extremo del surco como ocurre
en los surcos tipo cuia. Esto indica que la superficie ha sido completamente
removida, lo que sugiere que la remocién de la superficie puede atribuirse a
un aumento de sus propiedades mecanicas en la superficie. Esto como
resultado de la laminacion con rodillos rugosos y el consecuente tamafio de
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grano menor inducido en esa zona.

En la Figura 21b, se observa la muestra recristalizada a 400°C, en este caso,

al igual que en el anterior, es posible observar una remocion total del

material, aludiendo un desgaste caracteristico de corte.

(@) (b)

(@) (b)

Figura 21. Imagenes SEM de los mecanismos de degaste de muestras

laminadas con rodillos rugosos, a) 300°C, b) 400°C.

Mediante el andlisis del surco y la topografia de desgaste, es posible,
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concluir que la laminaciéon utilizando rodillos rugosos, contribuye a una
mayor resistencia al desgaste del acero de formal superficial, concordante
con los andlisis microestructurales, en donde en esa zona se encontré una
reduccion del tamafio de grano inducido por la rugosidad impuesta en los

rodillos de laminacion.

Finalmente, estos hallazgos sobre la resistencia al desgaste son de
importancia, ya que destacan como la eleccion entre rodillos convencionales
y rugosos puede influir significativamente en la capacidad del material para
resistir el desgaste y la abrasion durante su uso, lo que a su vez influye en
la durabilidad de piezas expuestas a condiciones adversas. La mejora en la
resistencia al desgaste con el uso de rodillos rugosos podria representar
una ventaja significativa en diversas aplicaciones industriales y

tecnoldgicas.

Las siguientes figuras son referidas a las pruebas de nanodureza realizadas

a las distintas muestras.

La Figura 22 muestra los resultados de nanodureza obtenida en las
muestras que fueron laminadas utilizando rodillos convencionales y

rugosos. Diferenciando entre la superficie y el centro de las piezas.

En cuanto a las muestras que fueron laminadas con rodillos rugosos, se
observa un incremento en los valores de nanodureza superficial versus el
centro de la pieza. Lo que no ocurre para aquellas laminadas de forma
convencional. Ademas, se observan que valores de nanodureza del centro

de la pieza, son similares en ambas muestras.

Estos resultados son consistentes con los hallazgos obtenidos durante el

analisis microestructural, donde se observé que el tamafio de grano en el

centro de la muestra era similar para las muestras laminadas utilizando

rodillos convencionales y rugosos. Sin embargo, se observaron cambios
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microestructurales superficiales significativos solo en las piezas laminadas

con rodillos rugosos.
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Figura 22. Curva de dureza versus laminacion convencional y con
rugosidad 300°C

La Figura 23 presenta la variacion de la nanodureza en funcion de la
temperatura de recocido de las muestras laminadas con rodillos rugosos.
Se observa que, a medida que aumenta la temperatura de recocido, se
produce una disminucién en los valores de nanodureza. Se tiene que un
aumento en la temperatura conlleva un mayor crecimiento del tamafo de
grano, lo cual, se asocia con un menor esfuerzo de fluencia y, por lo tanto,

con una menor dureza en el material.
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Figura 23. Curva de dureza laminacion con rodillos rugoso versus

temperatura de recocido.

La Figura 24 ilustra el perfil de nanodureza de una muestra laminada con
rodillos rugosos y recocida a 400°C durante 1 hora, en funcion de la
distancia a la superficie. En concordancia con los resultados anteriormente
sefialados, se observan valores de nanodureza mayores en la superficie del
material en comparacion con el interior de la pieza. Especificamente, la
nanodureza en la superficie de la muestra alcanza 5,8 GPa, mientras que
disminuye hacia el interior del material, llegando a un valor de nanodureza
de 4,9 GPa.

La disminucién de la nanodureza hacia el interior del material es coherente
con un mayor tamafio de grano en esa zona, no afectada por la deformacion
inducida por la rugosidad. Nuevamente, estos resultados destacan la

influencia del tratamiento superficial en las propiedades mecanicas del

material.
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Figura 24. Curva de nanodureza versus la distancia desde la superficie de
la muestra laminada con rodillos rugosos y recocida a 400°C durante 1

hora

Estos resultados son relevantes, ya que confirman que la laminacién con
rodillos rugosos tiene un impacto significativo en las propiedades mecéanicas
de la superficie del material. EI aumento de la nanodureza en la superficie
del material se debe al menor tamafio de grano en esa zona, consecuencia
de los multiples centros de nucleacién generados por la rugosidad, los que
durante el posterior recocido posibilitan la formacion de pequefios granos
recristalizados. Este hallazgo respalda la utilidad y la eficacia de la
laminacion con rodillos rugosos como un método prometedor para mejorar
las propiedades mecanicas y superficiales de los materiales, ya que pueden
tener aplicaciones importantes en diversas industrias donde se requiere un

rendimiento superior en términos de resistencia y durabilidad.
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4.2 Simulaciéon mediante FEM

A continuacion, se presentan los resultados obtenidos a través de la
simulacién, los que abordan la deformacién plastica del material, los
esfuerzos involucrados, asi como la presion y la fuerza de laminacién, tanto
en el caso de rodillos convencionales como en el caso de rodillos rugosos
utilizando el software Simufact, los cuales, fueron posteriormente

comparados con el software Ansys.

4.2.1 Simufact

4.2.1.1 Deformacién plastica

La Figura 25 presenta los resultados en la primera pasada de laminacion,
gue redujo el espesor inicial de 5 mm a 4,5 mm, utilizando un modelo de

deformacion 3D para todas las rugosidades.

La Figura 25a muestra la deformacion pléstica efectiva obtenida del modelo
utilizando rodillos convencionales lisos. Como se muestra en la figura, la
deformacion maxima corresponde a 0,29, mientras que la minima a 0,09.
Sin embargo, los valores minimo y maximo identificados en las zonas
delantera y trasera de la placa no proporcionan una representacion precisa
del comportamiento global de la pieza. La Figura 25b, 25c y 25d muestran
lo propio para rodillos con rugosidad baja, media y alta, respectivamente. La
Figura 26a presenta una ampliacién de la imagen que revela una variacion
gradual desde el centro de la pieza, que presenta una deformacion de 0,12,
hasta la superficie de la pieza, donde la deformacion alcanza un valor de

0,13-0,15, lo que indica en este caso una deformacion bastante homogénea.
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Las Figuras 26b, 26c y 26d, para rugosidades bajas, medias y altas,
muestran en cambio una deformacién mas heterogénea. Por ejemplo, en la
figura 26¢c, en la que se utilizaron rodillos de rugosidad media, la variacion
de las deformaciones en toda la pieza es mucho méas pronunciada. En el
centro de la pieza, la deformacion alcanza valores de 0,16, mientras que, en
la superficie, hay zonas con valores de deformacion similares (indicadas por
areas azules) donde la indentacion no deforma significativamente la pieza,
y otras zonas con alta deformacién, alcanzando valores de hasta 0,43
(indicadas por areas rojas) debido al efecto de indentacion de los rodillos

rugosos.

Reconociendo que los valores minimo y maximo por si solos no
proporcionan una vision completa del comportamiento global de la pieza, se
llevé a cabo un analisis detallado de diversas regiones de la pieza, tanto en
su centro como en la superficie, y se pudo identificar y registrar los valores
de deformacion que se detallan en la Tabla 7. Estos resultados proporcionan
informacién importante sobre como varia la deformacion a lo largo del
proceso de laminacion y como la rugosidad de los rodillos influye en la

magnitud y distribucién de la deformacion en la pieza.

En particular, se destaca que, en todos los pases de laminacion, se observa
un incremento significativo en la deformacion de la pieza a medida que se
incrementa la rugosidad de los rodillos, y este efecto es particularmente

notorio en la superficie.
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Figura 25. Deformacioén plastica efectiva del 1° pase del modelo utilizando
a) rodillos convencionales, b) rugosidad baja, ¢) rugosidad media, d)

rugosidad alta
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Figura 26. Imagenes con vista magnificada deformacion plastica efectiva
del 1° pase del modelo utilizando a) rodillos convencionales, b) rugosidad
baja, c) rugosidad media, d) rugosidad alta

Por otra parte, como era esperable, se observa un aumento progresivo de
la deformacion efectiva a medida que se incrementa el nimero de pasadas.

Este efecto es especialmente pronunciado en la superficie con rugosidad,
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debido al efecto de indentacion de los rodillos rugosos. Estos resultados
confirman cémo la utilizacién de rodillos rugosos impacta significativamente
en la distribucion de deformaciones a lo largo de la pieza y, por lo tanto, en

el proceso de nanoestructuracion superficial.

Finalmente, debido a la alta distorsion que se generaba en la malla al utilizar

rodillos de alta rugosidad solo se utiliz6 esa rugosidad en la primera pasada.

Tabla 7. Deformacién plastica efectiva de todos los modelos simulados

utilizando Simufact

Convencional Baja Media Alta
Pase

Matriz Superficie Matriz Superficie Matriz Superficie Matriz Superficie
1 0.13 0.13-0.16 0.13 0.13-0.23 0.16 0.15-0.43 0.28 0.68-1.2
2 0.26 0.29-0.35 0.28 0.28-0.36 0.30 0.30-0.87 - -
3 0.42 0.46-0.53 0.44 047-066 045 0.50-1.14 - -
4 0.61 0.66-0.79 0.65 0.63-0.86 0.66 0.75-1.49 - -
5 0.81 0.91-1.09 0.84 0.98-1.20 091 1.05-1.74 - -

6 1.08 1.17-1.42 114 1.31-155 1.22 1.40-1.99 - -

Los resultados de la tercera y quinta pasadas de laminacion se presentan
en las Figuras 27 y 28, respectivamente. Durante la tercera pasada, el
espesor de la chapa se redujo de 4 mm a 3,5 mm, mientras que en la quinta

pasada se redujo de 3,0 mm a 2,5 mm.

Como se mencion0 anteriormente, es evidente visualmente que la
deformacion se intensifica con la rugosidad, concentrdndose como era de
esperarse en la superficie. También puede observarse falta de
homogeneidad en la deformacion superficial, con zonas con niveles de
deformacion significativamente mas elevados, es decir la existencia de

elevados gradientes de deformacion en la superficie. Este patrén de
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deformacion no uniforme se debe a la rugosidad discontinua impuesta por

la superficie rugosa de los rodillos.

De acuerdo con lo anteriormente visto en las Figuras 16,17 y 18 se ilustra la
limitada aparicion de granos recristalizados en la superficie, mostrando una
distribucion no uniforme y heterogénea. Como se menciond, esta
fenomenologia es atribuible a la indentacion en la superficie, en donde la
elevada rugosidad del rodillo da lugar a un campo aislado y heterogéneo de
deformaciones. La evidencia de este efecto se presenta en las Figuras 25-
28, donde las regiones adyacentes al indentador revelan un grupo de altas
deformaciones superficiales, que potencialmente sirven como centros de

deformacion.

En resumen, los resultados muestran como la rugosidad de los rodillos
afecta la distribucion de deformacion en la pieza, generando una mayor
intensidad y gradiente de deformacion en la superficie. Esta deformacién
superficial no uniforme induce la formacion heterogénea de granos
recristalizados superficiales, con un bajo porcentaje de estos de tamafno
menos a 1 ym, aunque algunos de tamafio nanométrico, como lo revel6 la

evidencia experimental de Figura 16.
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Figura 27. Deformacion plastica efectiva del 3° pase modelo utilizando a)

rodillos convencionales, b) rugosidad
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Figura 28. Deformacion plastica efectiva del 5° pase modelo utilizando a)
rodillos convencionales, b) rugosidad baja, ¢) rugosidad media
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4.2.1.2 Esfuerzos

Se llevo a cabo un andlisis de los esfuerzos en la direccion vertical z durante
el proceso de laminacion utilizando rodillos convencionales y rugosos. La
Figura 29 ilustra la distribuciéon de dichos esfuerzos para la primera pasada
de laminacion para todos los caos. Por otra parte, en la Figura 30 se ilustran
el pase cuarto para laminacion convencional, y rugosidad baja y media.
Finalmente, en la Figura 31, se ilustra el pase sexto para laminacion

convencional y utilizando rugosidad baja y media.

Es importante sefialar que los valores negativos en la gréafica corresponden
a tensiones de compresion. Como era de esperar, se observa que la maxima
compresion se produce en la superficie del material y corresponde
practicamente a la presion de laminacién puesto que el angulo de
laminacién es muy pequefio, con un maximo de 3,6° en la primera pasada,

lo que significa que la normal al rodillo es sensiblemente vertical.

Ademas, se aprecia una tendencia al aumento de la presiéon con el nimero
de pasadas, tanto por efecto del endurecimiento por deformaciéon como, en
el caso de los rodillos rugosos, por la acumulacién del efecto de las

sucesivas indentaciones.
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Figura 29. Esfuerzo en la direccion vertical del 1° pase de laminacion del
modelo utilizando: a) rodillos convencionales, b) rugosidad baja, c)

rugosidad media, d) rugosidad alta
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Figura 30. Esfuerzo en la direccion vertical del 4° pase de laminacion del
modelo utilizando: a) rodillos convencionales, b) rugosidad baja, c)

rugosidad media
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Figura 31. Esfuerzo en la direccion vertical del 6° pase de laminacion del

modelo utilizando: a) rodillos convencionales, b) rugosidad baja, c)

rugosidad media

4.2.1.3 Fuerza de laminacién

Los resultados de fuerza de laminacion para diferentes rugosidades para la
primera pasada se presentan en la Figura 32. Se puede notar claramente
gue a medida que la rugosidad de los rodillos aumenta, también lo hace la
fuerza requerida para la laminacion. La diferencia entre la laminacion
convencional, y las de baja y media rugosidad es moderada. Sin embargo,
al compararla con la laminacién de alta rugosidad, se observa un incremento
significativo en la fuerza necesaria, principalmente debido a la marcada

rugosidad impuesta por los rodillos.
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La Figura 33a representa las fuerzas de laminacion para todas las pasadas,
utilizando rodillos convencionales, por su parte la Figura 33b, muestra la
fuerza de laminacion utilizando rodillos de rugosidad media. En el gréfico,
es evidente la esperada tendencia de aumento progresivo de la fuerza a
medida que se incrementa el nimero de pasadas. Este fenomeno se
relaciona con el efecto de endurecimiento por deformacion que se produce
con cada pasada sucesiva, y también al efecto acumulativo de las
identaciones en el caso de rodillos rugosos. Es importante destacar que el
largo de la zona de deformacidén es constante, puesto que la reduccién

absoluta en cada pasada también lo es igual a 0,5 mm.

Cuando se utilizan rodillos rugosos, los valores de la fuerza de laminacion
son significativamente mayores en comparacion con los rodillos
convencionales. Como se sefiald, este aumento se debe a la indentacion
creada por la superficie rugosa del rodillo. La rugosidad impuesta por los
rodillos rugosos genera una mayor resistencia al desplazamiento del
material durante el proceso de laminacion, lo que resulta en presiones y
fuerzas de laminacion mas altas en comparacion con los rodillos

convencionales.
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Figura 32. Fuerzas de laminacion para el 1° pase de laminacion todas las

rugosidades
79



Fuerza (KN)

—— pase1
pase2
—— pase3
—— pased
—— pase5
—— pase6

120 140

100 4 120

80 100 ~

80
60

60

Fuerza (KN)

40
40

20
204

, 038 0,0 ‘ ofz 04
Tiempo (s) Tiempo (s)

(a) (b)

Figura 33. Fuerzas de laminacién para todos los pases usando a)

convencionales, b) rugosidad media

Al realizar un analisis de los valores encontrados para la fuerza de
laminacion correspondiente al primer pase, se encuentra que para el caso
de la laminacion utilizando rodillos convencionales, los valores de la fuerza
fluctian en un rango de 78.3KN-96.2KN. En el anexo D, se encuentran en
detalles los valores de fuerzas tabulados para cada rugosidad obtenidos por

el software.

Por otra parte, para una baja rugosidad el rango se encuentra entre 83.5KN-
98.8KN, para la rugosidad media entre 91-5KN-119.4KN y para una alta
rugosidad este rango es de 128.3KN-172.7KN.

Al comparar los valores de la fuerza para la primera pasada entregadas por
este software con los valores tedricos se encuentra una buena correlacion.
Para estos efectos, se hizo uso de las clasicas ecuaciones para el célculo
de la fuerza de laminacién utilizando método del bloque segun Bland y Ford
para laminacion en frio, como se muestra con detalle en el anexo E. Se

encontré que la fuerza dada por esta ecuacion es de F=84.7 KN, la cual se
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encuentra dentro de los rangos entregados por el software, que son 78.3KN-
96.2KN.

Finalmente, el software de elementos finitos Simufact proporcioné una
adecuada representacion fenomenolégica de las deformaciones
superficiales y las condiciones mecanicas involucradas en el proceso de
laminacion, lo que es fundamental para comprender y correlacionar
adecuadamente los resultados obtenidos con las observaciones

experimentales.

4.2.2 Software ANSYS

4.2.2.1 Deformacion plastica

En las figuras siguientes se muestran las deformaciones plasticas
experimentadas por la pieza, simulando el proceso de laminacién utilizando
rodillos convencionales y con una rugosidad media. En la Figura 34, se
presenta la deformacién plastica resultante del primer pase de laminacién
con rodillos convencionales. Se aprecia que la deformacion plastica maxima

alcanza un valor de 0,189, mientras que el minimo se sitia en 0,078.

Al igual que en la simulacion previamente realizada con el software
Simufact, es importante notar que estos valores maximos y minimos, al
encontrarse en los extremos de la pieza, no proporcionan una Vvision
completa del comportamiento global de la misma. Es posible observar que
los valores de deformacion en la superficie varian en un rango de 0,13 a
0,16, indicados por colores verdes y amarillos. Estos valores guardan

relacion con los resultados obtenidos a través del software Simufact, lo que
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refuerza la consistencia entre ambas simulaciones, en lo que a rodillos lisos

se refiere.

La figura 35 muestra la deformacion plastica del primer pase para una
laminacion utilizando rodillos de rugosidad media. Los valores maximos se
encuentran en las zonas resaltadas en rojo, mientras que los valores mas
bajos se extienden en las zonas resaltadas en azul. Se observa que el
modelo muestra de manera coherente la distribucion de la deformacion
plastica en la pieza generada por la rugosidad impuesta en los rodillos, con
los valores maximos ubicados en la superficie de la pieza donde la rugosidad
de los rodillos entra en contacto con la pieza. Ademas, se observa también

en este caso, una distribucién heterogénea de la deformacion superficial.

Sin embargo, en este caso, la deformacién plastica arroj6é un valor maximo
de 0.252, resultado menor al 0.43 encontrado mediante el software
Simufact, posiblemente debido al hecho de no considerar en toda la zona
de deformacién un roce adherente con las discontinuidades de deformacion

asociadas.

A: Static Structural
Equivalent Plastic Strain
Type: Equivalent Plastic Strain
Unit: mm/mm

Time: 15

0,18939 Max
] 017698
= 016458
015217

. 0,13976

0,12735
0,10253

I 0,090121
0,077711 Min

15,000 30,000 (mm)
—
7,500 22,500

Figura 34. Deformacion plastica efectiva del 1° pase del modelo utilizando

rodillos convencionales
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ee—
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Figura 35. Deformacion pléastica efectiva del 1° pase del modelo utilizando

rodillos de media rugosidad

4.2.2.2 Esfuerzos

Se compararon los resultados de ambos softwares en términos de esfuerzos
verticales, los cuales, como se mencion6 con anterioridad son muy cercanos

a la presién de laminacion.

Los resultados obtenidos mediante el software Ansys utilizando rodillos
convencionales se muestran en la Figura 36, se observa que la presion
maxima es de 873 MPa, valor menor a 1141 MPa encontrado por el software

Simufact.

Por otra parte, la Figura 37 muestras los resultados obtenidos para rodillos
utilizando una rugosidad media. Es posible observar que el valor de la
presion maxima es de 1502 MPa, al compararlo con el resultado entregado
por el software Simufact, donde el valor minimo encontrado fue de 1344, se
observan que en este caso los valores son mayores a los entregados por el

software Ansys.
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Figura 36. Esfuerzo en la direccién normal del 1° pase del modelo

utilizando rodillos convencionales
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Figura 37. Esfuerzo en la direccion normal del 1° pase del modelo
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utilizando rodillos de media rugosidad

Dado que el modelo Ansys no contempla roce adherente en toda la zona de
deformacion, se hace particularmente dificil constatar sus resultados de
presiones con los del modelo Simufact. Eso explica el que se observen
tendencias inversas entre ambos modelos segun se trate de rodillos lisos o
rugosos.

Puesto que la precisién en la simulacion de un proceso de laminacion
depende de varios factores, incluyendo la calidad de los datos de entrada
como el tipo de friccion- adherente en este caso- en el contacto, la
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configuracion del modelo, y la capacidad del software utilizado, el modelo
Ansys para el proceso de esta tesis se revela como no apto para una
adecuada simulacién al no permitir la introduccion de roce adherente en
toda la zona de deformacion. Al considerar un coeficiente de friccion
arbitrario alto (0.45 en este caso) pero menor a 0.5 -limite inferior que
asegura adherencia en correspondencia a los planos de entrada y salida en
deformacion plana- siempre se va a sub y sobre estimar el roce maximo

dentro de la zona de deformacion.

4.3 Analisis de la Topografia Superficial tras el proceso de laminacién

La Figura 38 presenta la superficie de una muestra después de haber sido
sometida a seis pasadas de laminacion, con dos magnificaciones. En ambas
imagenes se aprecia claramente la rugosidad de la superficie generada
impuesta por los rodillos rugosos durante el proceso de laminacion. En
particular, en la Figura 38b, se presenta una imagen obtenida mediante
microscopia electronica de barrido, donde se observa una superficie libre de
microfisuras. Este fendmeno destaca la eficacia del proceso en la obtencion
de una superficie libre de fallas y resalta la presencia deseable de una

rugosidad controlada en esta etapa del procedimiento.

La figura 39 muestra el perfil de la muestra luego de 6 pases de laminacion.
En la Figura 39a, se indica el perfil en una escala proporcional entre la
profundidad y el ancho de la pieza. En la figura 39b se sefiala en escala
amplificada con el fin de resaltar la altura de los picos, encontrandose que
la altura aproximada de estos es de 150 pm, mientras que su ancho

corresponde a 1000 um aproximadamente.
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Figura 38. a) Superficie de la muestra luego de 6 pases de laminacién b)
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Figura 39. a) Perfil de superficie de la muestra luego de 6 pases de
laminacion b) con aumento
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4.4 Conclusiones Generales

Este estudio arrojo importantes resultados sobre los efectos de la laminacion
con rodillos rugosos en la formacién de micro/nanogranos superficiales,
revelando que se logra un refinamiento del tamafio de grano a nivel
micrométrico e incluso nanométrico a través del proceso de deformacion-
recristalizacion. Este fendmeno se origina debido a la generaciéon de zonas
de alta deformacion superficial que funcionan como centros de nucleacion
para la formacién de nuevos granos durante la recristalizacién. Sin embargo,
es importante destacar que la rugosidad pronunciada de los rodillos resulta
en la formacion aislada y heterogénea de estos nuevos granos superficiales.
Por otro lado, con rugosidades bajas, el rodillo se comporta como uno
convencional, es decir no se produce un particular refinamiento de grano

superficial.

Los hallazgos de la microscopia avanzada, incluyendo SEM y EBSD,
apuntan a la selectividad y localizacion en la recristalizacion y formacion de
granos nanométricos en la zona cercana a la superficie. Esta observacion
es esencial para comprender como la distribucion no uniforme de la
deformacion superficial influye en la microestructura resultante, lo que
puede tener un impacto en las propiedades finales del material. Ademas,
subraya la importancia de considerar la heterogeneidad en el proceso de
recristalizacion al disefiar y optimizar procesos de laminacion con rodillos

rugosos para obtener microestructuras con propiedades especificas.

Los resultados de las pruebas de resistencia al desgaste y nanodureza
respaldan la conclusion de que el refinamiento superficial del grano,
alcanzado en el proceso propuesto, aumenta la resistencia al desgaste del
material. Esto abre una perspectiva prometedora para producir materiales
de alta calidad, con propiedades superficiales mejoradas mediante la
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generacion de micro y nanoestructuras superficiales.

Finalmente, la simulacién mediante FEM proporciona evidencia concluyente
de que la eleccion entre rodillos convencionales y rodillos rugosos tiene un
impacto significativo en la deformacion, los esfuerzos y las fuerzas de

laminacion.

Se encontraron diferencias significativas en los resultados entregados por
ambos softwares, por lo cual, se concluye que la eleccién del modelo que
permita introducir adecuadamente la fenomenologia del proceso, en este
caso Simufact, con el roce adherente en el contacto metal rodillo, es clave

para obtener resultados coherentes.
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ANEXOS

Anexo A
Interfaz software Simufact y Ansys

| —— osv | ~%20-o0R-8-0

Ready UM

Figura Al. Interfaz software Simufact diferentes procesos de conformado
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Flat rolling
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Figura A2. Interfaz software Simufact diferentes procesos de laminacion
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Figura A3. Interfaz software Simufact diferentes tipos de friccion
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Figura A4. Interfaz software Ansys diferentes tipos de analisis
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Anexo B

Resultados mediante elementos finitos utilizando Simufact de
deformacion plastica para el primer pase de laminacién de todas las
rugosidades.

Effective plastic strain

0.29
0.27
0.25
0.23
0.21
0.19
0.17
0.15
0.13
0.11
0.09

max: 0.29
min: 0.00

Pass-1-3D - Results - 1 - |
Sub-stage: tablepress X
Progress: 100.00%

Select surface geometry coordinates

Figura B1. Deformacion plastica efectiva del 1° pase del modelo utilizando

rodillos convencionales

Effective plastic strain

0.50
0.46
0.42
0.37
0.33
0.29
0.25
0.21
0.17
0.12
0.08

max: 0.51
min: 0.00

Pass1-3D - Results - 1 v |
Sub-stage: tablepress X
Progress: 100.00%

Select surface geometry coordinates
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Figura B2. Deformacion plastica efectiva del 1° pase del modelo utilizando

rugosidad baja

Effective plastic strain @

0.60
0.55
0.50
0.44
0.39
0.34
0.29
0.24
0.18
0.13
0.08

max: 0.62
min: 0.00

Pass1-3D - Results - 3 v |
Sub-stage: tablepress X
Progress: 100.00%

Select surface geometry coordinates

Figura B3. Deformacién plastica efectiva del 1° pase del modelo utilizando

rugosidad media

Effective plastic strain @

1.42
1.29
1.15
1.01
0.87
0.73
0.59
0.45
0.31
0.17
0.03

max: 1.61
min: 0.00

Pass1-3D-3 - Results - 2 - |
Sub-stage: tablepress X
Progress: 67.38%

Select surface geometry coordinates

Figura B4. Deformacion plastica efectiva del 1° pase del modelo utilizando

rugosidad alta
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Anexo C
Publicaciones tesis doctoral
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Anexo D

Fuerzas de laminacién para todas las rugosidades, entre tiempo: 0.2 s-

0.3 s (valores de estado estable)

Tiempo Fuerza (KN)

(s) Convencional Baja Media Alta
0,20119 81,46896 | 94,02956 |105,97901|157,35069
0,20429 79,35455 |83,62666 | 97,5351 |167,67577
0,20738 95,34465 | 96,45961 | 97,02502 |172,73797
0,21048 80,89713 |83,54503 |100,61002|128,25674
0,21357 94,36343 | 85,09794 |111,94833|144,81236
0,21667 80,66947 |97,90786 | 112,1698 |157,67966
0,21976 78,33641 | 85,13909 |100,12106|164,69623
0,22286 95,30705 |96,47453 | 91,49019 |168,95977
0,22595 82,2242 86,80226 [110,49806 | 135,42022
0,22905 93,45988 | 95,08662 |119,43704|148,07441
0,23214 80,72236 | 97,03003 |112,36659|164,18038
0,23524 78,71622 |85,96811 |104,37744|169,02175
0,23833 94,31589 |93,51089 |/104,41702| 133,911
0,24143 81,1114 92,59532 |103,37765 | 150,93867
0,24452 96,20006 93,9234 104,30733|164,21419
0,24762 81,68509 |91,49253|107,11306|163,73123
0,25071 78,69407 | 87,59466 | 119,0488 | 165,26025
0,25381 95,29148 |94,49572 |106,48289|136,82344
0,2569 80,65788 | 97,37045 | 105,8456 |150,72198

0,26 93,05909 |95,85948 |102,81166|164,88323
0,2631 81,36629 | 97,80791 |102,66595|164,44184
0,26619 78,58591 | 88,64608 |107,41184|133,96361
0,26929 95,29756 | 93,56997 |112,26703|147,51541
0,27238 81,78738 |92,39422109,19091|162,71938
0,27548 93,49829 |91,80596 |102,83151|169,28178
0,27857 79,78393 |97,39962 | 97,40948 |134,19789
0,28167 78,53645 |86,32049 | 116,4528 |147,48898
0,28476 94,56855 |98,76274 |117,90627|168,05087
0,28786 81,22279 ]91,59408 |106,55529|167,27508
0,29095 94,76592 |83,61632|102,86919| 169,2982
0,29405 81,42641 |98,54449 |104,49661|138,43623
0,29714 78,40105 |87,62885|109,51381|155,07519
0,30024 94,4343 95,31402 | 105,49787]166,61211
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Anexo E
Calculo de la fuerza de laminacién

Como he sabido en todo el proceso de deformacion plastica intervienen en
mayor o menor medida la deformacion homogénea, el roce interno y el roce
de las intercaras de metal herramienta. Considerar estos 3 factores para la
determinacion de las variables de interés es extremadamente complejo. Sin
embargo, existe un método tradicional para tratar un problema plastico plano
0 asimétrico. Esto es, el método del bloque, el que considera soélo la

deformacion homogénea y el roce la intercara metal-rodillo.

Las suposiciones usuales de éste, para la laminacion tanto en caliente como
en frio, son que el material que se esta deformando es un medio continuo e
isotrépico. Se introduce una serie de simplificaciones de tipo matematico.
Se desprecia el ensanche. Se desprecia la deformacion elastica del
material. Se usa el criterio de fluencia de Von Mises. El &ngulo de laminacion

a es pequefio. No hay aceleraciones ni desaceleraciones.

La diferencia fundamental entre la laminacion en caliente y la laminacion en
frio dice relacién con el tipo de friccion que existe la intercara, de ahi que los

andlisis mediante el bloque se plantean en funcion del roce existente
Célculo de la fuerza de laminacion utilizando rodillo convencional:
Se consideré el Método del bloque segun Bland y Ford para Laminacion en

frio. La expresion de la fuerza de laminacion segun este meétodo es:

Op

2
F=b’ﬁ6M\/R’Ah 1-—— |fs(arb)
Vet

Donde f3 es una funcion que considera la friccion y las tensiones externas y

gue depende de los parametros a, r y b. Su valor se encuentra graficamente.
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1=
=0y

R’ Ah V3

a=u |—, r= , b= , B=1Inb

jh: h; 1- %
—0
\/§M

B —K(Zl 1 )”

Oy = \/§n1—rM

™™ = 0-4rprevi0 + 0.67¢otar

Realizaremos el calculo de la fuerza considerando el primer pase esto es

reducir desde 5mm a 4.5 mm.
Partiremos por el célculo de la reduccion
Ah 0.5
Ttotal = h_L =r z 0.1
Tprevio = 0
En este caso se tiene que la reduccion media es:
v = 0.47previo + 0.67101q = 0.06

Se calcula ahora el esfuerzo medio

B —K(ZZ 1 >”
O = \/§n1—rM

Donde K=130-%_ n=0.45

mm?2’

2 0.45 Kg
5y = 130 (—l —) = 39.65
oM /3 '1-0.06 mm?

Se calculan los parametros de los cuales depende f3,

R’ 63.5mm
a=u h_f:O44 mzlo

b =1,pueso;, =0 =0

B=Inb=In1=0
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Factor para lafuerza de laminacién F en frio

De la gréafica se observa que fz= 1.25
Finalmente
F=b -5 JR| 1-=" | farb)
=b—= i ar,
\/g M i_ 3
Radio rodillo: R'=63.5 mm

Ancho del material: b’:25 mm
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o,= 0, pues no existen tensiones delanteras

2 Kg
F =25mm X — X 39.65
V3 mm?

F =8061.7Kg = 79KN

X V63.5mm x 0.5mm x (1) x 1.25

Si se considera la curvatura de los rodillos, se debe volver a calcular el

nuevo radio del rodillo R’, de acuerdo con Férmula Hitchckok

R | 2CF
R bAh
2
2CF 2 % 0.11% x 8.0617
R’=R(1 —)=63.5 x| 1
t oan mm + 25 x 0.05

R' = 72.5098 mm

!

— =114
R

R’ no es el radio de curvatura real, se debe iterar nuevamente
Se calcula un nuevo valor F’ utilizando R’

F'=8614.7Kg
Con este valor de F’ se calcula R”

mm?

2CF' 2% 0.11707 x 8.617Ton
R'=R(1+——)=635mmx|1
< * bAh) mm x| L 25 X 0.05
R" = 731278
R 10085
R

Por lo tanto, R” es el radio real de curvatura y se calcula la fuerza F” con
este radio

F'=8651.3 Kg = 84.783 KN
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Anexo E

Tutorial Software Simufact

A continuacion, se detalla el proceso de simulacion utilizando software

Simufact para laminacion.

Examples rolling Hot rolling

Table of Contents

1.1. Hot rolling ... S
1.1.1. Process description and objective of the simulations 3
1.1.2. Set up the 2D simulation ... 203
1.1.3. Performing the 2D simulation 28
1.1.4. Postp ing the 2D si i 29
1.1.5. Set up the 3D simulation ... 31
1.1.6. Perform the 3D simulation . 34
1.1.7. Postprocessing the 3D simulation 34
1.1.8. Creation and adaption of the 3D process to perform pass 2 35
1.1.9. Perform the simulation of pass 2 38
1.1.10. Postprocessing of pass 2 40
L 1L L BXOTCISE s vsnissvsninpinssns 41
1.1.12. Further reading and information 41

1.1. Hot rolling

Figure 1.1. Hot rolling

Keywords
2D, 3D, Finite-Element-Solver (FE), HexMesh meshing, Hot forming, Rolling, StageControl, Steel
Educational objectives

The major purpose of the entire tutorial is to teach you how to use Simufact Forming. This example is a simple rolling
model that can be modified easily to a cold, warm or caliber rolling process model.

This model can be extended to a two pass rolling model with reversing operation. The two simulation steps can be
arranged automatically with respect to their kinematics.

Prerequisites

Basic knowledge of the process, Quickstart

117



Examples rolling Perform the simulation of pass 2

Insert process
Import process...
Insert stage control
Collapse all

Optimization >
Thin out project >

Properties

Figure 1.64. Inserting a stage control

You can assign Pass1-3D and Pass2-3D to the object StageControll in the process tree by drag&drop.

v Y StageControll

Figure 1.65. Stage control with both passes

Through this stage control function Simufact Forming will run both processes in sequence automatically.

By right-clicking on the object Pass2-3D that is assigned to StageControll and picking Properties you can

open the dialog controlling the results imported from a previous step.

v H}S StageControll
..y Pass1-3D
[y Pass2-3D
Delete Del

Properties

Figure 1.66. Opening the dialog to control the imported results from previous steps

In the tab Components activate the following components.

% HexaGon
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Examples rolling

Perform the simulation of pass 2

Project

(4 Additional files

Pass1-2D
Pass1-3D

v . Pass2-3D

v 5 Rotation-reverse
v . UpperRoller
P UpperRoller
-5 Coloumb0.44
L 20C
v P LowerRoller
P LowerRoller
.22 Coloumb0.44
-} 20C
v i}, Workpiece
T8l Mesh
(P Workpiece
-7 DB.Ck15_h3
4 1000C
7% Hexmesh
v fiif Pusher-1

-(# Pusher-1

28 Coloumb0.01
-} 1000C
& Dielnsert-x-free
v ¥l Pusher-2

(P Pusher-2
-5 Coloumb0.01
- 1000C
.25 Compressed-x

. E] Contact table
ﬁ Forming

e At Ambient temperature (20 °C)

Figure 1.63. Process tree after defining pass 2

1.1.9. Perform the simulation of pass 2

To run both steps automatically a stage control is needed. It can be added by right-clicking in the process tree and

selecting Insert stage control:

7 Hexacon
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Examples rolling

Creation and adaption of the 3D
process to perform pass 2

2 Compressedx

Menu
General
Stiffness
Force
Model view

“nital condition -
The springs...
() released @ compressed

. by the given maxmum dispacement

Drection (D) X v

Dsplacement (x) E mm v
Relatve to (FE only)

This spring is relatve to...

@ the ground another body

UpperRoler

Brief descrption (hold Cirl key to lock)

Die springs re Lised to describe the mavementand A | €
behavior of certain dies like blark holders.

Ade sprng can be defned reative to another 0
{movng) body.

Desprngs can te attached only todies thatdo b

ol cos

Figure 1.62. General spring parameter for pass 2

You can assign the new die spring to Pusher-2 by drag&drop. The process tree should now look like this:

% HexaGon
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Examples rolling

Creation and adaption of the 3D
process to perform pass 2

(3 Project v &b Geometries
(& Additionalfiles 4 Reference geometries
Pass1-20 &) LoveRoller
:asi’ig (P Pusher-1
Vi (@ Pusher-2
v -5 Rotation-reverse @ Urperiial
v ¥ UpperRoller i -BReioTe
Deijpe 5] Workpiece
sterials
Copy
DB.Ck15_h3
M Rename
Delete Del Rotation
Positioning > Manual positioning
W Reset positioring Autometic positioning (roles)
B Eport Save current position
g Export to Joining Optimizer Apply displacement to
o Crezte flowlines Hexmesh
B Creste paricles e types
v Create post-particles Comipfiusediy
@ 3 Dic nsert-x-free
= Get from previous stage
@ Properties
-3
v ., Pusher-2
(P Pusher-2
Coloumb0.01
4§ 1000C
> Dielnsert-x-free

A Ambient temperature (20°C)
8] Contact table
& Forming

Figure 1.60. Opening the manual positioning dialog

5¢] Manual pesitioning X
Trensfarmation

(8] [ol @] @ % ™o
z v [20 | lmm | 4] [
[[]stepping

0.0 mm

oK Cancel

Figure 1.61. Parameter for the positioning of the UpperRoller

Translate the roller by clicking on @ in negative z-direction and close the dialog with OK.

In Pass2-3D not only the direction of the rotation is reversed but also the direction of the pusher motion. Please
delete the spring object Compressed+x of die Pusher-1 and the object DieInsert-x-free of Pusher-2.
Afterwards assign the object DieInsert-x-freeto Pusher-1.

The direction of action of the die spring has to be reversed. Copy the object Compressed+x in the object catalog
and rename it to Compres sed-x. Change the Direction (D) to -X:

% HexaGon
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Examples rolling Creation and adaption of the 3D
process to perform pass 2

1.1.8. Creation and adaption of the 3D process to per-
form pass 2

The objective of this chapter is to show the set up of a multistage rolling process using a stage control.

Create a copy of the process Pass1-3D without results. Rename the new process to Pass2-3D. To define the

rotation of the rollers in reverse direction create in the object catalog a copy of the object Rot at ion and rename it to
Rotation-reverse. Edit the table definition so that the direction of rotation flips and the rotation time is extended:

% Rotation-reverse x
Menu Press typs: |Tzbuiar moton (trangaton &rotation) v
Press
Plot Table type: Timefvehaty v
ey Time Tonsx-velocity  Tansyvelocty  Tomszvelocty  Angulorvelocty | |4
s ~ mm/s v mm/s ~ mm/s ~|Rpm v|s
00 00 00 00 270
0.7 00 00 00 270 )
075 00 00 00 00 *
Erief description (hokd Ctrlkey o lock]
ble point kst (%]
st of al tabie points defined for thi press =
L+
(]
o Carcel

Figure 1.59. Rotation of the rolls for pass 2

Before you assign this kinematics to the process Pas s2-3D you have to delete the old kinematics in the process tree.
Then you can assign the new kinematics object to the process by drag&drop. Finally you have to assign the rollers
to this kinematics.

The positioning of the rollers can be done by right-clicking on the UpperRoller in the process tree and selecting
Positioning > Manual Positioning:
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[s#] Forming control (FE) x
Menu
Stroke Manel’
Sub-stages @ Fixed time steps O Automatc © Manual 210 (8] | specy...
Output divisions
Output results Adaptive time stepping based on...
Step control Automa! Manua
Parallelization =
> Advanced O .. Automatic ©) Manua > | Spedfy...

Figure 1.57. Forming control: Step control

1.1.6. Perform the 3D simulation

Before you start the simulation you should save the project. Start the simulation by clicking on Start analysis » L
Now your simulation is checked for errors. If there are none click Start analysis.

1.1.7. Postprocessing the 3D simulation

The postprocessing of the 3D simulation can be performed according to the 2D simulation.

One useful result value in the 3D rolling simulation is the Contact, which visualizes the projected length or the contact
of the rolling stock to the rollers.

Contact
Full contact QA

No contact

Figure 1.58. Result value contact

The representation of the components in the results and model view can be changed by selecting them in the process

tree or by clicking on them in the results or model view and using the buttons b B B @ . In this example

only the Workpiece and the LowerRoller are shown.

34
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Workpiece = 5 (P =|
Origin of mesh
Create mesh with current mesher v
& Mesher: Hexmesh v
é’- Element type: Hexahedral
E' -
=
F]
=

Blement size m

Element count: 0
Inside coarsening level: |2 '+

Advanced

Refinement boxes

Figure 1.55. Mesh settings for 3D simulation

Create the mesh by clicking on Create initial mesh.

Close the meshing dialog by clicking OK. The question whether you want to use the initial mesh parameters for the
remeshing has to be answered with Yes. The meshing object is assigned to the workpiece in the process tree and
appears in the object catalog automatically.

1.1.5.3. Simulation specific adjustments

Double-click on Forming in the process free to open the Forming control (FE). Please make sure that settings in
the Forming control according to the following figures.

[s¥] Forming control (FE) X
WMeit Direction - Stroke / time

Stroke 1 Stroke: v Specify stroke...

Sub-stages

Output divisions [ ] rmefo s > Control...

Output results

Additional termination criteria

Step control
P [] Terminate on contact:

Parallelization
Advanced [] Terminate on max. press force

[[] Terminate on max. tool force Configure forces...

Animation
Speed ————

‘5 Auto repeat

Figure 1.56. Forming control: Stroke

The time has not to be specified for tabular defined presses because the solver automatically uses the
maximum process time given in the table.

4

You can preview the kinematics of the rollers and the pushers by clicking on :] An another click stops
the animation of the kinematics.
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Project

(& Additional files
m. Pass1-2D
Rename

Copy >

Delete Del
Collapse all

Insert >
Show model view

Show result view

Show report

Open process folder
Simulation >
Update result steps

Import results

Properties

v &b Geometries
P4 Reference geometries
6 LowerRoller
(@ Picher-1
Copy without results

Copy with results

(& Workpiece

v 7 Materials
< DB.Ck15_h3

v P Presses
S Rotation

BT Friction

> G Temperatures

v B4 Remeshing
5 AdvFront

w: @ Die types
£ Compressed+x
«& Dielnsert-x-free

Figure 1.53. Copying a process

Rename the new process to Pass1-3D. Because we modeled the 2D simulation with 3D geometries it is very easy
to switch from a 2D simulation to a 3D simulation. Open the process definition by double-clicking on the process

name. Select 3D as Simulation type.

@ Procesz definition - “Pass!-30
Rolling © O ©

|change applcaten mocule

Process type
|Flatroling

Smulzton type
®=

O D - axeymmetric
O D -panar

Saiver type
Firite Elements (FE)

Anmbicnt temperature

0.0 e~
Process temperature range

QOtdld @ =t

Dies

Quntty: 4 7

Briefescrpton (hoe Ctr ey o lock)

Add tmestamp

Process selection

The process typa should be selected n accordance to the process smulabion 1o be camed out. varous settings in
o the availabie meshing algorithis, scttngs in the foming contral and numerical parmeters are
dysted o best sut fhe process tpe to be simiiater based o the selecied arpication moce erd the selected

process type. If the process type is changed, these setungs wil be automatcally recet to ther default vaes.

oK Cancel

Figure 1.54. Process definition for 3D simulation

1.1.5.2. Meshing of the workpiece

To perform a 3D simulation you have to adapt the mesh settings. Open the mesh dialog, choose the Mesher Hexme sh

and enter an Element size of 1.3 mm.
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Graphical options g x

[ Result lines [] Grid

[ Highlight selection

[ show current increment
[] show points Size: &
[] tine width ~ width: 2

r

Figure 1.51. Graphical options menu

If you click a result line now the animation window will show the selected increment.
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18
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<9 more>
max: 1.95
min: 0.00
> . e 4433 )

Figure 1.52. History plot synchronised with animation
Alternatively you can also select an increment in the animation window using the control panel or animate the entire

simulation by clicking on the animation. The actual displayed increment is visualized by a green highlighting in the
history plot.

1.1.5. Set up the 3D simulation

1.1.5.1. Process definition

Generate a copy of the 2D process by activating it and right-clicking on it. In the context menu select Copy > Copy
without results.

% HexaGoN 31



% HEXAGON

Examples rolling Postprocessing the 2D simulation
[ History plot [Pass1-20] o x
File  Edit  Window B S
F 1 i A ¥ W Upparfoler qu ,;‘ ﬁ:
4 m’\[ W-VV’W\(\/W V wemnn E’\ B
¥ [1% Rotation El =
[ @ UpperRoller B a
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Figure 1.49. Simulated force for the UpperRoller

that stay in contact change during the remeshing).

As you can see the curve is discontinuously. This is caused by the remeshing that is done several times (the nodes

Arrange the animation window and the history plot by clicking on Window > Tile. Manually resize and move the
history plot, so that both windows are visible at the same time:

a3 o4
Time (s}

T Seesion s
= AR X S o oy
VWAV A A | s o E =
\ v 0% Retion BEow
\ 2 8 Ui B
\ ) @ LoweRotier |
\ + Wokgeee | =
i\ 09 weigecr [
\ e
\ e Bh
\ [ ve—
\ i (o4 i
i \‘ et oay
\ "
\
/
|

Figure 1.50. Arranged result and animation windows

Then you can select the tab Graphical options in the history plot window and activate the option Result lines.
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[s] Start analysis - Pass1-2D X

User-defined DAT fie
[J Auto apply DAT file modifications
Extended start
[ Remote profie: | N Aufingasr

e
= >
Queue analyss Start analysis

Brief description (hold Ctrl key to lock)

Start analysis
Press this button to start the analysis.

Figure 1.47. Start analysis
Start the analysis with click on Start analysis.

1.1.4. Postprocessing the 2D simulation

Open the result view by clicking on Animation ﬂ or by double-clicking on [ Results jp the process tree. In this
process type the default result value is effective plastic strain when opening a new result view. By clicking on the
title of the legend the result value can be changed.

Figure 1.48. Animation of the result value effective plastic strain

By clicking on E you can start the animation.
The next step is to display the simulated rolling force for the UpperRol ler. First you have to activate the Upper-

Roller by clicking on it in the process tree. Then you can create a history plot for the rolling force by clicking on & ‘i
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[5] Forming control (FE) x
Menu Mode
Stroke il
Sub-stages @) Fixed time steps O Automatic @ Manual Specify...
Otikput diisions
Output results Adaptive time stepping based on...

Step control
Parallelization
> Advanced O ...distortion Automatic Manual = Spedify...

.recydes Automatic Manual <

O ...increment strain change
...temperature change
Switch at | Automatic
O ...displacement change Automatic Manual

O ...auto step for tables

Brief description (hdd Ctrl key to lock)

Step control
Define the step control mode andjor how many steps the solver should compute.

Qo

Restre perats T o

Figure 1.46. Step control

A Fixed time step of 210 is entered here under the Mode Manual. With this value, the movement of the rollers
in one time step corresponds to about two thirds of the tangential element size of the rolling stock, so that a stable
rolling simulation can be ensured.

1.1.3. Performing the 2D simulation

Before you start the simulation you should save the project. Then start the simulation by clicking on Start analysis

@ . The button is located at the bottom of the Simufact Forming window. Now your simulation is checked for errors.
If there are none, following dialog will appear:
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7] Contact table X
Body has contact with Contact options
& Workpiece & @ LowerRoller Direction: Defauit ¥
M @ Pusher-1 Contact type: Touching v
g : Pusher-2 Contact tolerance: 0.0 mm v
UpperRoller —_——————
B & Workpiece Contact bias factor: 10 |
[] Near-contact tolerance:
[] mnitial stress-free projection
Gluing temperature:
properties
Separation at: 1.0e+14 |MPa )
Fricton sress it wea v
[[] Friction coefficent ():
[] interface friction factor (m):
Prestress options
[ interference dosure
Overlaps
Overview
Body Contact Direction  Type Tolerance [mm] Biasfactor  Near-contact tol. [mm] Separation at [MPa] | |
Workpiece ~ Workpiece  Default Touching 0.0 0 - 0.0 0*
Workpiece  UpperRoller  Default Touching 0.0 0 0.0 ;
Workpiece  Pusher-1 Default Touching 00 0 - 1.0e+14 \
Workpiece ~ LowerRoller  Default Touching 00 0 = 0.0
Workpiece  Pusher-2 Default Touching 00 0 1.0e+14

Figure 1.45. Contact table dialog

1.1.2.11. Definition of the step control

Finally, a reasonable step size should be selected for the simulation. To do this, double-click Forming in the process
tree, switch to the Step control submenu and change the settings according to the following figure:
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8 Project
(& Additional files
v - Pass1-2D
~ Rename
Copy
Delete Del
Collapse all
Insert

Show model view
Show result view

Show report

v &b Geometries
‘d Reference geometries
B LowerRoller
(@ Pusher-1
a Pusher-2
6 UpperRoller
(P Workpiece
Dies >
Workpiece
Symmetry plane

Constraint plane

Open process folder FE contact table
V- E Remeshing
Simulation & AdvFront
Update result steps v % Die types
J Import results Z Compressed+x
Properties B Dielnsert-x-free
e
@ 1000C
= Compressed+x
v ), Pusher-2
(P Pusher-2
B8 Coloumb0.01
& 1000C

% Dielnsert-x-free
@ 20 Simulation
A Ambient temperature (20 °C)
9 Forming

Figure 1.44. Inserting a contact table

The contact between the workpiece and the pushers and the rollers have to be defined manually. Therefore select
Workpiece in the field Body and activate the pushers and rollers in the field has contact with. All Contact options
can be left unchanged. Only the Mechanical properties of the pushers have to be modified. Set Separation at to
1.0e+14. This entry prevents separation of the workpiece from the pushers. Please verify that the contact table as

following looks like and finish the contact table dialog:
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1.1.2.9. Meshing of the workpiece

To mesh the workpiece double-click on the mesh object in the process tree. This opens the mesh dialog that you can
input the following settings:

[ Workpiece Y |
Origin of mesh -

Create mesh with current mesher v

§
]

Advandng FrontQuad v
Element type: Quads, plane strain (11)

Element count: 4300

Mesh properties

Refinement boxes

Figure 1.43. Mesh dialog

Start the meshing by clicking on Create initial mesh. Close the meshing dialog by clicking on OK. The question
whether you want to use the initial mesh parameters for the remeshing has to be answered with Yes.

1.1.2.10. Definition of the contact between the pushers and the

workpiece

The pushers have multiple functions in this model:

* They define the end planes of the workpiece from which the workpiece is not allowed to separate. Due to this
fixation the length of the workpiece to be represented in the model can be shortened because the quasi-stationary

state is reached more faster.

* They should push the workpiece into the rolling gap until the desired conditions are fulfilled. In every single pass
the pusher behind the workpiece is used for this function.

* They position the workpiece at the beginning of a pass in front of the rolling gap.

To define the special contact conditions present in this process a FE contact table has to be added to the process.
Right-click on the process name and select Insert > FE contact table:
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¢ Dieinsert X
Fixed Press  Generic spring (FE only)
= X[ | O O
l ¥ O O
z O O
Rotation
Fixed Press  Generic spring (FE only)
x M O O
¥ O O
z Ll O
Brief description (hold Ctrl key to lock)
Specify which or i are allowed for the die.
To define a free movement, uncheck all these options.
Lo ]/ con |

Figure 1.41. Setting for the die insert

Rename the die insert object to DieInsert-x-free and assign it to Pusher-2.

1.1.2.8. Defining the 2D cutting plane

Double-click on 2D Simulation in the process tree to open the dialog for defining the 2D cutting plane. The cutting
plane should automatically be in the workpiece center. If not, it can be positioned in the center of the workpiece via
the button Set to workpiece center. Furthermore you have to enter a workpiece thickness to calculate the forces for
the rollers. Enter the value here according to the figure below.

Y

= |
] i3]
Matens tudness

o0 s
» S

Pass1-20 - Model view ‘
Select suface geametry coordnates x

Figure 1.42. Defining the 2D cutting plane
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2 Edit/Show initial force table X
Points Curve chart
Time (X) Force (Y) B 4
B vl a3 353
0 1e-07 é {
0.05 4 i 3
007 1e-07 - - !
|1 1e-07 o = - j
g 23
|
w15 i
134
T T T T T T T T T T 1
( 02 04 06 08 1
Time [s]
[J comment
Brief description (hold Ctrl key to lock)
Curve points

The coordinates of the curve are ksted. The sampling points are in the first column, followed by the corresponding values and possibly temporary curves.

Figure 1.39. Spring properties: Initial force table

After entering all properties close the table and die spring dialog. Rename the die spring object to Compressed+x
and assign it to the die Pusher-1.

In order that Pusher-2 can follow the displacement of the workpiece, the degree of freedom in x-direction of it has
to be enabled. To do this, right-click in the object catalog and choose Die types > Die insert > Manual, deactivate
for the translation the fixation in x-direction:

Geometries
Materials
Presses
Friction

vy v v v

-

Temperatures
Remeshing
Heat treatment
Die types

Boundary conditions

3 Dieinsert > 3 Manual
£ Diespring » [l Library
Z  Generic spring

Electromagnetic
Initial conditions
Predefined tables
Clipping planes

vy v v v v v v v

Remove unused

Show filter
Sort >

d4d ¢ ¥xEBPLPTHFNE GAHIL S

Expand/Collapse »

Figure 1.40. Opening the die insert dialog
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Z Diespring X
Menu [ Fixed - ‘ :
General Stiffness [1.0e-06 ==
SF"" ness [ Table driven (only for FE) -
l\:;::l view As function of Displacement (®) Time
Number of table entries 0 2
Brief description (hold Ctrl key to lock)
Specfy here whether the stiffness is constant (fxed) | |
or defined by a table. ‘l,,,
©
(V)
o 10 oo |
Figure 1.37. Spring properties: Stiffness
Z Diespring %
Menu [ Fixed -
General Initial force 0.0 N vl
SF:iffness ] Table driven (only for FE)
rce
Model view Force as functionof O Displacement (@ Time

Number of table entries [0 | | (%]

Brief description (hold Ctri key to lock)

Specify here whether the additional force is a constant
(fixed) initial force or defined by a table.

[

Figure 1.38. Spring properties: Force
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1.1.2.7. Definition of the pusher kinematics

The pusher that pushes the workpiece into the rolling gap is controlled by a die spring. The die spring has a time-
dependent force. Define a die spring by right-clicking in the object catalog and choosing Die types > Die spring >

Manual:
“ Geometries »
77 Materials »
P Presses »
&8 Friction »
@ Temperatures »
2 Remeshing »
E Heat treatment »
3 Dietypes » P Dieinsert > |
%, Boundary conditions 3 Die spring » £ Manual
% Electromagnetic » 2 Generic spring > () Library
Initial conditions »
Predefined tables »
46 Clipping planes »
Y Remove unused
T Show filter
T sort »
E&  Expand/Collapse »
Figure 1.35. Opening the die spring dialog
Z Die spring X
Menu Initial conditon ——————————————
General v i
Stiffness O released @ compressed
Force ...by the given maximum displacement
Model view
O | Direction (D)
D } Displacement (x) [500.0 mm v
Relative to (FE only)
This spring is relative to...
@ the ground
UpperRoler
Brief desaription (hold Ctrlkey tolodk) ——————
Die springs are used to describe the movementand A e
behavior of certain dies like blank holders.
A die spring can be defined relative to another 0
(moving) body.
Die springs can be attached only to dies that do v O
nat have a die incert
Coc ][ cane
Figure 1.36. Spring properties: General
7 Hexacon 21



Examples rolling Set up the 2D simulation

At first select the Press type: Tabular motion (translation & rotation):

P Press (Toble press) %

Menu Press type: Tabuder roton (iansiabon & roteion)

Press

Plot Teble type: [TimeNekcty v

History Time Trans -vek Tansyve Tanszvel o y 3

s v mm/s v mm/s ~mm/s ~ |Rpm v| &

T
+

9

Brief description theld Ct key to lock)

Table point fist o
Ustof al table ponts cefined for thia press. =
(+]
L

Figure 1.33. Press dialog

After choosing the press type a table appears, which you shall parameterize next. Define the time-dependent angular

velocity. Add a new dataset by clicking on +‘ in the table. By double-clicking on the entered values in the dataset
they can be edited.

S Press (Table press) 4
Menu Press type:  Tabulsr moton (frarslation & rotetion) v
Press
Plot Table type: Time Velocty -
sty Time Tonsxvelocity  Tonsy-velocity  Tanszvelocty  Anguiarvelocty | (o
s ~ | mm/s ~ | mmvs ~ | mmis | Rpm ~| s
00 00 00 09 70 =
05 [ [ 00 20 +
055 00 00 oo [ +
>
Bref cesption (hokd Ct ey 10 o)
Table point st ©
Ust of ol tabie ponts cefined for this press. ,
&
L)
oK Cencel

Figure 1.34. Definition of the angular velocity
Finish the dialog with OK and rename the created object in the object catalog to Rotation.

The assignment of the press object differs from the previous assignments. At first the press object is assigned to the
process by drag&drop.

Then the rollers have to be linked with the press object. This can be done also via drag&drop. Take the dies Upper—
Roller and LowerRoller inthe process tree and drop them to the press, so that both rollers are below the press
in the hierarchy.

The definition of the roller kinematics is now finished.
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The defined axis and rotation direction are now displayed in the model as long as the button EE] is activated:

7

Model legend

Workpieoe.
LowerRokr
Fusher-t
Pusher-2
Upperfler

Pass1-2D - Model view

Figure 1.31. Model with defined rotation axes

In this figure the rotation directions are correct. If the rotation direction is not correct you can reopen the dialog to define

“—
the rotation axis and click on Reverse direction to invert the rotation direction. Finish your change with OK.

To define the rotation speed, right-click on Presses in the object catalog and select Manual to open the press dialog.

> &b Geometries
v 2 Materials
& DB.CKIS_h3
F Presses
v @& Friction
S5 Coloum [l Library
S8 Coloum
v @ Temperatu,
@ 1000C
& 1000C
@ 2¢

§* User-defined

> &b Geometries
v 27 Materials
&7 DB.CK15_h3
P Presses
v IR Friction
Coloumb.01
BS Coloumb0.44
v} Temperatures
@ 1000C
& 1000C
@ 20c

&b Geometries »
Materials »

Friction » [ Library
Temperatures ¥ B User-defined
Remeshing

Heat treatment

Die types

Boundary conditions
Electromagnetic
Initial conditions
Predefined tables
Clipping planes

Remove unused

v v v v owowow

Show filter
Sort ’

W
=
4
fe
%
2]
*
A3
T
b 4
Fa

Expand/Collapse »

Figure 1.32. Open the press dialog
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Information
Please pik the frst pont to defne the ratalon (2) axs. |
Select surface geometry coordnates x

Figure 1.29. Dialog to define the rotational axis and the local coordinate system

Now you can select three nodes around the contour of the roller which should ideally have an angle of 120° to each
other for reasons of accuracy when calculating the axis of rotation.

If you do not know the rotation direction just pick one. It can be changed easily afterwards.

The selected nodes are highlighted and the rotational axis with the rotation direction is shown:

Model lagend
B vpperkoler

Pease pck o fourth pont ta define the x axa of the beal coordnate system. Y l
Select surface geometry coordnates x

Figure 1.30. Defined rotational axis and rotation direction

Close the dialog with OK. Define the rotational axis for the LowerRoller inthe same way.
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G Workpiece Temperature X

Workpiece temperature - initial or reheated:
Heat transfer coefficent to environment (HTC): ﬁ
@ (constant ~ | [s0.0 ) o | - 0
Emissivity for heat radiation to environment: :
1 (R (e S
Brief description (hold Ctrl key to lock)
Sets the heat for die and workpiece components. (%)
¥
LP)
o1 conadl

Figure 1.27. Workpiece temperature dialog
Drag&drop the created temperature object to the workpiece.
1.1.2.6. Definition of the roll kinematics
The definition of the roll kinematics is done in two steps:
 Definition of the rotational degree of freedom, the rotational axis and the positive sense of rotation
* Definition of the rotation speed.

At first a rotational axis is defined. Right-click on the geometry object of roller UpperRoller in the process tree
or in the object catalog and choose Rotation axis/local system.

v &b Geometries
k Reference geometries

a LowerRoller
G Pusher-1
(P Pusher-2
i UpperRoller ]
View
Copy
Rename
Delete Del
To library
Modify geometry »
Rotation axis / local system

Rolling direction
Define path of coil for inductor
Transferred results

2 Export

K Use as reference geometry

Figure 1.28. Opening the dialog to define the
rotational axis and the local coordinate system

In the opening dialog you can illustrate the elements of the imported geometry by clicking @ . The following screen
will appear:
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Drag&drop the temperature object to the process name in the process free to assign the temperature to all dies.

As you can see the pushers have been assigned the same initial temperature as two rollers of 20°¢C. This would
influence the forming process because the pushers cool down the contact zone to the plate. That is undesired and
another die temperature object for the pushers have to be created. This can be done analogously to the previous step.
Please create a die temperature object with an Initial temperature of 1000°C and a Heat transfer coefficient to
workpiece of 0 W/ (m? K).

@ Die Temperature X
Tnitial di temperature:

A& constant 1000.0 C v
Heat transfer cosficient fo ervironment (HTC):

@ Constant +|[s00 Wi =
Heat transfer coefficent to workpiece:

§ o | —— 7 —

Emissvity for heat radiation te envircnment:

«’,5’;% Automatic v | [surfece medun v

Brief description (hold Cu key to lock)

Sets the heat for die ard warkpiece componerts. ©

Figure 1.25. Die temperature object for pushers
Drag&drop this temperature object to the pushers. The old temperature object will be replaced.

Open the context menu by right-clicking on Temperatures in the object catalog and choosing Workpiece > Manual:

&b Geometries &b Geometries
Zz Materials 7 Materials
S Presses P Presses
T Friction Friction
v o} Temperatures v ) Temperatures

@ 1000 @ Die v & 100

o 1000C ¥ Workpiece  » ¢ Manual
Library e

Geometries
Materials
Presses
Friction

Tempenatures

Remeshing
Heat treatment

v v v v~

@ Die
¥ Workpiece

Eg_

Library

Dietypes
Boundary conditions
Electromagnetic
Initial conditions
Predefined tables
Clipping planes

¢ xOBLRFHNE B4

Remove unused

Show filter
Sort »

<<

&

% Expand/Collapse »

Figure 1.26. Opening the dialog to create the temperature object for the workpiece

Change the Workpiece temperature to 1000 °C, all other values do not require any modification. Close the dialog
by clicking on OK.
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It is possible to assign a friction object individually to a single die. This allows every single object have a different

friction law.

Note that you can rename every object by right-clicking on it and selecting Rename. It is very helpful to use self-
explanatory names. Especially if you have to handle a lot of objects.

1.1.2.5. Definition of the thermal properties

Please open the dialog for the die temperature by right-clicking on Temperatures in the object catalog and selecting

Die > Manual:

v “ Geometries
*‘. Reference geometries
(P LowerRoller
(P Pusher-1
(P Pusher-2
(@ UpperRoller
0 Workpiece
v I Materials
< DB.Ck15_h3
S Presses
v BB Friction
B8 Coloumb0.01
&S Coloumb0.44
&} Temperatures
@ Die » A Manual

& Workpiece  » [} Library

> &b Geometries
v I Materials
@ DB.CK15_h3
S Presses
v BB Friction
&8 Coloumb0.01
8 Coloumb0.44
7} Temperatures

Geometries
Materials

Presses

Friction
Temperatures
Remeshing

Heat treatment
Die types
Boundary conditions
Electromagnetic
Initial conditions
Predefined tables
Clipping planes

Remove unused

Show filter
Sort

“4-< ¢ ¥xOBLPF&SNE BHHLE

fied

Expand/Collapse

v v v v -

v v vwovowvowow

@ Die > @ Manual
W@ Workpiece  » ([} Library

Figure 1.23. Opening of the die temperature dialog

All preset values can be taken over unchanged. You can finish the dialog by clicking on OK.

g Die Temperature

Tnitid de tempesature:

A Constant 20.0
Heat trarsfer cocfficient to envirorment (HTC):

B oo

Heat trarsfer coefficient to workniece:

§ 5
Emissivity for heat radation to environment:
{Q} Automatic ~| |surface:
briaf descripton (noid Crrl key tolozk)

Sets the heat for die end workpiece comporents.

Z W)

medum

cdoeo

x Cancel

Figure 1.24. Die temperature dialog
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v &b Geometries > &b Geometries
‘4 Reference geometries v Zz Materials
(P LowerRoller & DB.Ck15_h3
(P Pusher-1 S Presses
(P Pusher-2 BT Friction
(@ UpperRoller L Temperatures
5 &' o Wc.nkpiece a Geometries >
%atoc:;l:]s h3 22 Materials »
P Presses - P Presses >
F Friction &5 Friction v = Manual
) &% Manual ) Temperatures » |]] Library
Library 4 Remeshing »
E Heat treatment >
@ Die types >
% Boundary conditions »
gf Electromagnetic 4
@ Initial conditions >
Predefined tables ’
* Clipping planes >
% "> Remove unused
T show fitter
Y Sort >
& Expand/Collapse >

Figure 1.21. Open context menu to create a friction object

Change in the friction dialog to the Specification mode Manual. Activate the Coulomb Friction law by clicking on
Coulomb and enter a Friction coefficient of 0. 44. Accept and exit the dialog with OK.

B Friction X
Menu General
General Spedification mode: |Manual v
Die wear

Friction law =

Coulomb Shear Combined FuM
Parameters
o fricion:

Friction coeffident (u) [0.0-0.5]: Constant v | (0.44

Brief description (hold Ctrl key to lock)
Friction coefficient constant (&)
Please enter a constant value to be used as friction coefficient. o
©
o [ concl

Figure 1.22. Friction dialog

Rename the new friction object to Coloumb0 . 44 and drag & drop it to the process name to assign the friction object
to all tools.

Define a second friction object and enter a Friction coefficient of 0.01 and name it Coloumb0.01. Assign this
object to both pusher tools.
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%] -
»
Material Mini: P [*C]  Maxi P [*C]1 DIN JS AISI  AWS A r‘
& ck1s_ Internal name 1.1141 S15CK 1015 ‘
Material area of application 1.1141 $15CK 1015 @
Matesiol group 1.1141 S15CK 1015 «®
B CK15.  Material condition 1.1141 S15CK 1015
@ Ck15_ 1y Minimurm temperature [C] 1.1141 S15CK 1015
 cis, ¥ Maximum temperature [*C] i 158N R 04
& cu3s. s 1.1181 S35CK 1035
B cias, oy, ot 1,181 S35CK 1035
& cus ¥ DN 11191 S45CK 1045
% cuas ¥ IS 1.1191 S45CK 1045
& ckas_ ¥ Al 1.1191 S45CK 1045
& ckas_ ¥ AWS 11191 S45CK 1045
@ CkS3_ '« GB 1.1210 S53C 1050
% cks3. Import source 11210 $53C 1050
?} Ck67 Created by 1.1231 S70C 1070 5 y ’
= Modified on date
Import date
Tool material (purely elastic behavior)
Rigid plasticity
Default material
2 Damage
Anisotropy E Cancel
Microstructure
Phase transformation
Electromagnetic properties
Creep properties
Powder characterization
Minimum effective plastic strain
Maximum effective plastic strain
Minimum strain rate [1/s]
Maximum strain rate [1/5] 2
Plasticity model M

Figure 1.20. Opening a context menu to display more information about dataset

Finish the dialog by clicking on OK. You will now find the material in your object catalog. Using drag and drop you
can assign the material to the workpiece.

1.1.2.4. Definition of friction

To add an object that defines the friction you have to right-click on Friction in the object catalog and choose Manual:
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to select only datasets being categorized by AISI standards

oM Simufact Material 2021 (beta) - o X
File Baras  Help

Materials
%] 1Bof7a0 [k v
Doka yecord propeces Matenal  Minimum temperature ['C] Maximum temperatu A
Name Values G Ck15_h1 70085 112085
Material group | General steel v| |8 crisnz s 1200
Area of application | Hot | |8 ck15_h3 800 1250
Temperature [°C] | Nothing selected | |8 crisha so0 1250
Material condition | Nothing selected v| |& ciisns es0 1050
Standards st | 1% cesh e 1205
Plasticity model  Nothing selected o| | crsh 10785 132085
Material propertics [Nothing selectedl <| |% cashr 1080 1330
Impert scurce | Nothing selected <| | cresni 79985 119985
Import date Nothing selected o| | cris 2 coo 12
B> Cki5_h3 500 1250
& cresna 700 1250
T Cks3_h1 69985 109985
B Cks2_h2 700 1000
& k67 h 700 1000 * I
< > 2|
Brief Ctr key to lock)
List of materials

Alistof materas s shoan that have the seiected propertes and belong 1o te selected group.
Temperature of epoleation: ¢ = cold, h = hot, w = warm, u = universal

(Heat) Treatment condition: r = as roled, s = soft arncaled, 2 = anneded, n = nermalized, k = kiled
swindcates Smufact Welding materials

o] e ]

Figure 1.19. Material database

We pick the dataset of the Ck15 h3. This dataset contains material properties originating from MATILDA-database
and is valid for a temperature range from 800°C to 1250°C. Please note that you can activate more data columns
providing properties of each dataset by right-clicking on one of the column headers:
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Model legend
s &
LawerRoler
Pusher-1
Pusher-2
UpperRoler

Pass1-2D - Model view . I
x

Figure 1.17. Model after positioning

1.1.2.3. Definition of the material properties

Open the material database by right-clicking on Materials in the object catalog and choose Library:

8 Project v & Geometries 1 Project
-G Additiona files & Reference geometries S Adapil e
v @ Pesst-2D @ Loweoller uimwm
v B M"’ ':' @ pusher-1 ‘i Mesh
~g Mes » @ Workpiece
@ Wiorkpiece g z“’h" z. v @ UppesRoller
v @ UpperRoller pperRolier .9 UpperRoller
erRoller v @ Pusher-1
v @ ﬁ;ﬁ: @ Pusher1 i3
@ Pushert v @ LowerRoller SR Friction v
ol @ LoweRolies o
v @ LowesRoller v @ Pusher-2 O s
(P LowerRoller @ Pusher2 B Remeshing »
v @l Pusher-2 -1 20 Simulstion = Hexttreatment >
(@ Pusher-2 Amm_uumumnm‘zl B Dietypes &
g 2D Simuletion 8 Foming & o T
K Ambient temperature (20 °C) S Hecror d
-8 Forming [ initial conditions »
B Predefined tebles »
& Chpping planes 3
%> Remove unused
T showfiker
T son »
P& Expand/Collspee »

Figure 1.18. Opening the material database

A steel according to AISI 1015 should be used. To find the correct dataset you can change the filter in the data record
properties field and type in Ck:

Area of application Hot
to select only datasets to be used in hot forming
Material group General Steel
to select only datasets to be used for general engineering purpose

Standards AISI
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[s7] Manual positioning X
Transformation
g e 8@ L SC)
Align component: |Pusher-1 i
x: [Ma ~| |
y: |Keep =
z |Keep X
... to: | Workpiace o
x: [vin v 4
y: |Cente o
z: |Center bt
>
o o

Figure 1.15. Bounding box alignment for Pusher-1

Start the positioning with m and close the dialog window with OK. The die Pusher-2 will be positioned using
the Bounding box alignment, too:

[s¥] Manual positioning X
Transformaton
a8l @ w & [©
Align component: |Pusher-2 755
x: | Min 3|2
v: [Kesp ~
z: |Kesp =
«. to: |Workpece o
x: |Max 5 /
y: |Center 4
z: |Center 15
>

==

Figure 1.16. Bounding box alignment for Pusher-2

It is recommended to save the model again at this stage.

10
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Project
(& Additional files
v @, Pass1-2D
v i)} Workniece
Die type
Copy
v Rename
v Delete
Positioni
v @
Reset positioning
v @ Export
Export to Joining Optimizer
@
A Create flowlines
i} Create particles

Create post-particles

Get from previous stage

Properties

v &b Geometries

K Reference geometries
(P LowerRoller

(@ Pusher-1

(P Pusher-2

@] UpperRoller

(P Workpiece

Del | Materials

> Manual positioning

Automatic positioning (roles;

Save current position

Apply displacement to

Figure 1.13. Calling the positioner

Select the Gravity positioner ( ) and use the following settings:

* Method: Translational

* Direction: X

Manual pesitioning X
al[o @@ HEo
Positioner
Method: [Translasonal v =
Direction: X pallld
Combined positioning
oK Cancel

Figure 1.14. Gravity positioner

By clicking on the button you can start the positioner. Now the workpiece will be positioned in positive x-direction
until contact is found. After a short calculation time the workpiece is in contact with rollers. Click OK to save the
new position and close the positioning dialog.

The die Pusher-1 will be positioned using the Bounding box alignment ( ). It should be in contact with the
workpiece. Please use the following settings:
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This will open the tool dialog. There you can select the tool geometries for the rollers and pushers. By clicking on OK
the tools are inserted in the process tree and the geometries are assigned in the same step.

5] Increase dies from existing geometries x

Default type: |Riad de without heat conducion v | Defauttpress: |Nore v | [E2]

Model e attach to press

[“iLowerRoller  Rigid die without heat conduction v None Y ==
A Pusher-1 Rigid dic wit i ~ None ~| 1=
] Pusher-2 Rigid die without heat conduction « None v

~ Rigid die i | None ~

] Workpiece Rigid die without hezt conduction ~ None v

Brief descrption (nold Cirlkey to lock)
List of avalzbie models for the current process.

I =

Figure 1.11. Tool dialog

The geometry of the workpiece can be assigned to the process tree directly. Use the drag & drop function to assign
the geometry object from object catalog to the process tree.

Now the project should look like below. At the moment both pushers are at the same position.

Model legend
Workpec: XM
LowerRaler
Pusher-1
Pusher:2
UpperRoler
Pass1-2D - Model view
— L x

Figure 1.12. Project after assignment of the geometries

You will notice that there is no contact between the workpiece and the rollers or the pushers. To get a better stability
and reduce the computation time there should be an initial contact.

Please save the model before you start the positioning so that it will be possible to recover the actual status.

Call the positioning dialog by right-clicking on the workpiece in the process tree:

T Hexsaon 8
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‘When assigning a geometry from the object catalog to the process tree a renaming is automatically done. To provide
a comprehensible structure you should check if the geometry objects are named meaningful otherwise rename them
like this:

* UpperRoller#l as UpperRoller

* LowerRoller#l as LowerRoller

* Pusher#l as Pusher-1

* Workpiece#l asWorkpiece

Copy the geometry object Pusher-1 using the following menu and leave the suggested name unchanged:

Project v b Geometries

(& Additional files ¥4 Reference geometries
v @ Passi-2D (P LowerRoller

» @)’ Workpiece

@ 20 Simulation

View
A Ambient temperature (20 *C) @ Upperk &

: lorkpie
ﬂ Forming @ w ‘s Copy
77 Materials B
% Pr Rename
BB Friction Delete Del

@) Temperatu ) Tolibrary
Modify geometry »
Rotation axis / local system
Rolling direction
Define path of coil for inductor
Transferred resuits

) Export

k Use as reference geometry

Figure 1.9. Copy of a die

Now the tools can be inserted and the imported geometries are assigned to the tools in the process tree. By right-
clicking on the name of your process you can enter a context menu. Choose Insert > Dies > from existing geometries:

Project v &b Geometries
(] Additional files #4 Reference geometries
v @ Pass1-2D (P LowerRoller
> Rename (P Pusher-1
Copy > (P Pusher-2
Delete Del (P UpperRoller
Collapse all (P Workpiece
Insert > Dies > from existing geometries
Show rodel view Workpiece by a specific number

Show result view Symmetty plane

Constraint plane
FE contact table

Show report

Open process folder

Simulation >
Update result steps
Import results

Properties

Figure 1.10. Inserting the dies
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2 CAD import... X

« 4+ [ « rollng » fatsoling » hotsoling » CAD-Duts v o AD-Duta” duscheuche
Neves Ordoer e m @ Please provide the length unit of the geometry in the following file:
: w Grote (7 Rolling.STEP

Length unit of imported geometry

[] Determine unit from CAD file

Ao

Polling STEP

- Unit: | Millimeter Use unit for all geometries

General import options

Import as single body

i Brief desription (hoid Ctrl key to lock)

i Geometry import dialog
In ths dialog the geometry import options can be configured.

Oatcinamme: [Roling STEP <] [stepCaep=ate) v E

s

Figure 1.6. Import dialog

Model legend 1

LowerRolir# 1
Pusher#1
Workpiece#1
UpperRoler s

Information

Figure 1.7. Import settings

After the import the following geometries appear in the object catalog.

v a Geometries
K Reference geometries
(P LowerRoller#1
(P Pusherl
(P UpperRoller#1
(9 Workpiece#1

Figure 1.8. Object catalog with imported geometries
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@ Project
(4 Additional files
v @ Pass1-2D
> Rename

Copy >
Delete Del
Collapse all
Insert >
Show model view
Show result view
Show report
Open process folder
Simulation >
Update result steps

Import results

Properties

Figure 1.4. Renaming the process

Save the project by clicking on Save project .

1.1.2.2. Geometry definition

Right-click on Geometries in object catalog and select Import CAD (Surface mesh) or right-click in object catalog
and select Geometries > Import CAD (Surface mesh) to call the CAD-Import dialog:

Project v Geometries 18 Prot ~ & Geometries

B il condtions
] Predefmed tables
X Cligping plnes

(B Addional fles B Fromfie et & e gromei
varma o3 e | s
@ 20 Simubtion T import A0 Gurtace mesh] A = Fiction
A Ambient temperature (20 °C) W oy 8 foming ' € Tmpasiers
8 Forming i Baicshape 5 Geomeries W fomie
Fl From result & Mateals P Y Meshfrom file
Roll forming » P preses * 1 import CAD (uface mesh)
| = Ficion W) ey
© Tmpeatures v Bucoape
o , B Fomean
B futrimes | Melomg 2|
@ Dienper ,
% Boundary conditions >
¢ Dectomagoeic ,
.

% Remove unused

T showfite
T son »

Fe Epend/Cotiaze »

Figure 1.5. Call the import dialog

In the opening dialog select the STEP-geometry data in the folder C: \Program Files\simufact\form-
ing\2023.2\sfForming\examples\rolling\flat rolling\hot_ rolling\CAD-Data and then
import the geometries using the following settings:
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Yy Process definition - new process for project "rolling-en’’.

Rolling © & ©

Crarge aoplizton module

Pracess bype Comment

|Flatroling v] @ 8 a0z comment
Smulatentype ——————————
(O]

O 20 - axisymmetric

® 20 - plarar

Solvertype —————————————————————
Firite Slements (FE)

Ambient temperature

S
Process temperature range

Ocdd @ Hot

Des —————————————————

Quantity: <

Bricf description (hoid Ctl key tolock)

|Add tmestamn

Process sclection

The process type shoukd ba selectad in accorcance to the procass simulaton to be carried out. Various setingsin
respect 1o the avallable meshing agorithms, Settings In the forming contral and nLmeical parameters are
adjusted to best suit the process type to be smuiated based on tre selected epplcatio module and the selected
orocess typs. If the process type & changed, these settings vill be automatically reset = their dafaut values.

o e

Figure 1.3. Process definition

Choose the following settings:

* Process type:
Flat rolling
* Simulation type:
2D - planar
* Ambient temperature:

20: °¢

* Process temperature range:

Hot
* Dies:
0

Finish your input with OK.

Rename the process to Pass1-2D. In general it is not necessary to change the names but it is recommended to use

self-explanatory names.
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1.1.1. Process description and objective of the simula-
tions

In this Finite-Element simulation a thick plate of 15 mm thickness is rolled in a single pass to 10 mm thickness. For this
purpose, the CAD data provided are imported and the tool and process properties are assigned. During the simulation
the rolling forces and the projected length shall be determined.

In this simulation no plug is used. Therefore, the rolling stock only has line contact with the rolls at first, which implies
that the bite condition and the pass condition are not met. To get a sound surface contact in the rolling gap a pusher
is used to press the slab in between the rolls and to keep the outer sides of the rolling stock flat. This means that a
segment from the center of the real rolling stock is simulated. After the bite condition and the pass condition are met
the rolls transport the workpiece based on the friction contact. From that point on the pusher has no influence on the
simulation any more.

Firsta 2D - planar process is modeled. Afterwards the process is performed as a 3D simulation. Finally a second pass
will be modeled as a 3D simulation.

When selecting the simulation type 2D - planar a plane strain state is supposed, i.e. the results in this direction are
identical. This simplification can be done, if the geometry and the forming conditions are homogeneous in one of the
three dimensions and the length of this dimension is much longer than the other two dimensions.

1.1.2. Set up the 2D simulation

Open Simufact Forming.

1.1.2.1. Process definition

Create a new project by clicking on New Project O . This opens the selection of the application module.

B Select epplication module 3
- - L
=% o
‘ ar
Cold forming Hot forging Sheet metal forming General
] K B
|
[F
Rolling Ring roling Open die forgng Heat treatment
— =)

Mechanical joining Pressure welding

Bricf description (hold Ctf key tolock)

Application modules ~ O
Deperding on the sclected appication modue, Smufact Forming uses appropriate default setiings
concerning the sclver technology, meshing and the machine kinematzs. These settngs can be o
ad)sted iater vithn reascnable bourdsries.
g " e v O
Restore Defaults oK Cencel

Figure 1.2. Select application module

Select the application module Rolling and change to the process definition by clicking on OK.
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@ Pass1-3D -> Pass2-3D X
Menu Please note that the component names of successive stages have to match!
Components Component o=
Vv Positioning [ @ Workpiece =
Rotmop O ' UpperRoller =
Translation & @ Pusher-1 E:
Bounding box sher:
Increment [0 @ LowerRoller
Transferred results & @ Pusher-2
Fold detection
Brief description (hold Ctrl key to lock)
Component selection e
Results from the previous stage will be transferred for all components selected
on this page. The result transfer between two stages is performed based on 6
identical component names.
o 10 cone

Figure 1.67. Dialog to select the object to be imported

In the tab Positioning > Translation enter for the workpiece a translation in the x-direction of 150 mm:

@) Pass1-3D -> Pass2-3D X
Menu Component Tranelation
Components & Workpiece 2 -
Y. p°5hi°“i't'9 & UpperRoller mm v
Rotatlo!:l @ Pusher-1 2
Transltion = mm

Bounding box & LowerRoller
Increment & Pusher-2

Transferred results
Fold detection

Brief description (hold Ctrl key to lock)

Translation
On this page a translational displacement can be defined for the transferred
body.

(vl (=

o]/ e

Figure 1.68. Translation during the import
Repeat the entry shown above for Pusher-1 and Pusher-2. Save the project and start the simulation by clicking

on StageControll inthe process tree to activate it and then clicking Start analysis $ X

1.1.10. Postprocessing of pass 2

The postprocessing of the variation is not described separately. It can be done like the postprocessing of a single
simulation.
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